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Περίληψη  
 

 

Το 2007 ξέσπασε μία μεγάλη πυρκαγιά η οποία έκαψε 36.338 στρέμματα του 

Εθνικού Δρυμού Πάρνηθας, από τα οποία τα 21.800 ήταν δάσος κεφαλληνιακής 

ελάτης και σημαντικότατοι βιότοποι της άγριας πανίδας. Η περιοχή αυτή συνιστά 

έναν από τους λίγους Εθνικούς Δρυμούς της Ελλάδας και ανήκει στο δίκτυο 

προστατευόμενων περιοχών Natura 2000. 

Η παρούσα διπλωματική στοχεύει στην εκμετάλλευση των υπαρχόντων 

δεδομένων για τη δημιουργία χωρικού μοντέλου πρόβλεψης αναβλάστησης στις 

καμένες εκτάσεις με τη χρήση μεθόδων Γεωπληροφορικής, και Στατιστικής. 

Τοιουτοτρόπως, χρησιμοποιήθηκαν έξι δορυφορικές εικόνες διαφορετικών 

ημερομηνιών λήψης από το δορυφορικό πολυφασματικό δέκτη Landsat TM, σε 

συνδυασμό με χωρικά δεδομένα εδάφους της πιλοτικής περιοχής.  

Κατόπιν, βάσει βιβλιογραφικής έρευνας  επιλέχθηκαν οι παράγοντες, οι οποίοι 

επηρεάζουν την αναβλάστηση στη συγκεκριμένη περιοχή μελέτης. Οι παράγοντες 

που επιλέχθηκαν ήταν το υψόμετρο, η κλίση, η έκθεση, η απόσταση από το 

υδρογραφικό δίκτυο, η απόσταση από το οδικό δίκτυο, οι χρήσεις γης και η ηλιακή 

ακτινοβολία.  

Η επεξεργασία των δεδομένων αυτών  οδήγησε στην ανάπτυξη ενός χωρικού 

μοντέλου πρόβλεψης της αναβλάστησης. Τα στάδια επεξεργασίας των δεδομένων για 

τη δημιουργία του μοντέλου ήταν δύο. Στο πρώτο στάδιο εφαρμόστηκαν μέθοδοι μη 

χωρικής στατιστικής ανάλυσης όπως συχνότητες, συσχετίσεις και Γραμμική 

Παλινδρόμηση. Αντίθετα, στο δεύτερο στάδιο εφαρμόστηκε μία μέθοδος χωρικής 

στατιστικής, η Γεωγραφικά Σταθμισμένη Παλινδρόμηση.  

Εν τέλει, με τη δημιουργία του μοντέλου αυτού, μπόρεσαν να διεξαχθούν 

χρήσιμα συμπεράσματα για την πρόβλεψη της αναβλάστησης. Συγκεκριμένα το 

χωρικό αυτό μοντέλο έδειξε ότι μπορεί να  γίνει πρόβλεψη για αναβλάστηση σε όλη 

την περιοχή, εκτός από νοτιοδυτικά και ανατολικά της περιοχής. 

 
Λέξεις Κλειδιά: Αναβλάστηση, Χωρικά Μοντέλα, Παλινδρόμηση 
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Abstract 
 

In 2007, broke out a big fire which burned 36,338 acres of Parnitha National 

Park, of which 21,800 were forest Abies cephalonica and significant habitats of 

wildlife. This area is one of the few National Parks of Greece and belongs to the 

network of protected areas Natura 2000. 

This thesis differs in the implemented studies as there is to re-mapping of burnt 

areas of Parnitha, but aims to exploit existing data to create spatial revegetation 

predictive model in burned areas using methods Geoinformatics and Statistics. 

Thus, were used satellite images of different shooting dates from the satellite 

receiver multispectral Landsat TM, combined with spatial soil data of the pilot region. 

Then, based on literature review were selected factors affecting revegetation in this 

study area. The factors selected were altitude, slope, exposure, distance from the river 

network, the distance from roads, land use, and solar radiation. 

The processing of these data led to the development of a spatial model of 

prediction of revegetation. The data processing steps for creating the model were two. 

In the first stage implemented methods non spatial statistics as Average, Frequency, 

Correlation and Linear Regression. In contrast, in the second stage was implemented a 

method of spatial statistics, the Geographically Weighted Regression. 

Ultimately, the creation of this model, could be carried out useful findings for 

predicting revegetation. Specifically, the spatial model showed that this provision can 

be made for re-growth throughout the region, except the southwest and east of the 

region. 

 

 

 

 

Key Words: Regeneration, Spatial Models, Regression 
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ΕΝΟΤΗΤΑ 1: ΕΙΣΑΓΩΓΗ 
 
 
1.1 Σκοπός 

 
Μία από τις σοβαρότερες απειλές των δασών, ειδικά σε χώρες που βρίσκονται 

γύρω από την Μεσόγειο, όπως είναι η Ελλάδα, είναι οι δασικές πυρκαγιές. Χρόνο με 

το χρόνο, το μέγεθος των καμένων εκτάσεων και ο αριθμός των πυρκαγιών 

αυξάνονται.  

Σύμφωνα με επίσημα στοιχεία, από το 1970-2000 εκδηλώθηκαν πάνω από 

25.000 πυρκαγιές και κάηκαν πάνω από 6.600.000 στρέμματα δασών, δασικών 

εκτάσεων και λιβαδιών (Καρτέρης και Κούτσιας, 2001). 

Ειδικότερα οι δασικές πυρκαγιές συμβάλλουν στη διαμόρφωση της οικολογίας, 

αφού επηρεάζουν το φυσικοχημικό περιβάλλον, ενεργούν ως ρυθμιστής της 

συσσώρευσης της βιομάζας, προσδιορίζουν τη δομή και διάταξη των βιοτόπων, 

ρυθμίζουν τη βιοποικιλότητα καθώς και άλλα χαρακτηριστικά και διαδικασίες των 

οικοσυστημάτων όπως παραγωγικότητα, κύκλο θρεπτικών συστατικών κ.λπ., 

επηρεάζουν την αισθητική του τοπίου, το βαθμό διάβρωσης κ.λπ.  

Η συμβολή της χρήσης τεχνικών δορυφορικής τηλεπισκόπησης είναι σημαντική 

σε προβλήματα που αφορούν την διαχείριση και ανάλυση των φυσικών πυρκαγιών 

και την παρακολούθηση της αναβλάστησης των περιοχών που επλήγησαν.  

Η μεγάλη πυρκαγιά του Ιουνίου 2007 στον Εθνικό Δρυμό της Πάρνηθας έκαψε 

36.338 στρέμματα. Από τότε έως και σήμερα, οι περισσότερες υλοποιηθείσες μελέτες 

αφορούσαν μόνο τη χαρτογράφηση των καμένων εκτάσεων της Πάρνηθας, την 

ανάπτυξη γενικά συστημάτων διαχείρισης των δασικών πυρκαγιών και τον 

οικολογικό απολογισμό της καταστροφικής πυρκαγιάς του 2007. 

Για να καταστεί πιο σαφές, έχει πραγματοποιηθεί εκτίμηση - απολογισμός της 

καταστροφής που προκλήθηκε από την πυρκαγιά αλλά δεν έχει αναπτυχθεί κάποιο 

μοντέλο πρόβλεψης της αναβλάστησης σε αυτές τις καμένες εκτάσεις. 

Στόχος της συγκεκριμένης διπλωματικής εργασίας είναι η αξιοποίηση των 

δυνατοτήτων της Τηλεπισκόπησης, των Γεωγραφικών Πληροφοριακών Συστημάτων 

(Geographical Information Systems – GIS) και της Στατιστικής με σκοπό τη 

δημιουργία ενός μοντέλου, το οποίο θα μπορεί να εκτιμήσει αν θα γίνει αναβλάστηση 
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και σε ποιο βαθμό, στην περιοχή μελέτης και εάν ναι, εάν η αναβλάστηση έχει την 

ίδια δυναμική σε κάθε τμήμα της περιοχής μελέτης. 

 

  

Για να επιτευχθεί ο στόχος μας ακολουθήθηκαν οι παρακάτω διαδικασίες, οι 

οποίες περιγράφονται διεξοδικά στις επόμενες ενότητες της διατριβής: 

 

• Βιβλιογραφική έρευνα για τους παράγοντες που επηρεάζουν την 

αναβλάστηση σε μία καμένη περιοχή. 

• Μελέτη της καμένης περιοχής της Πάρνηθας ως προς τη χλωρίδα και την 

πανίδα.  

• Διεξαγωγή συμπερασμάτων για την επιλογή των παραγόντων της 

αναβλάστησης, βάσει της βιβλιογραφικής έρευνας.   

• Προεπεξεργασία και επεξεργασία δεδομένων μέσω Στατιστικής και 

Γεωπληροφορικής για τη δημιουργία ενός χωρικού μοντέλου πρόβλεψης της 

αναβλάστησης.  

• Σύγκριση των αποτελεσμάτων της χωρικής στατιστικής με τα αποτελέσματα 

της μη χωρικής στατιστικής. 

• Ανάλυση του μοντέλου και διεξαγωγή συμπερασμάτων για την πρόβλεψη της 

αναβλάστησης στην περιοχή μελέτης. 

 

 
1.2 Συστήματα Γεωγραφικών Πληροφοριών (GIS) 
 
 

Η εξέλιξη της τεχνολογίας των υπολογιστών, των εφαρμοσμένων μαθηματικών, 

της ψηφιακής χαρτογραφίας, της τηλεπισκόπησης, της γεωδαισίας, των βάσεων 

δεδομένων, των τεχνικών χωρικής ανάλυσης, των δομών αναπαράστασης γνώσης και 

των συστημάτων λήψεως αποφάσεων δημιούργησε το υπόβαθρο στο οποίο 

βασίστηκαν και μετεξελίσσονται τα Γεωγραφικά Συστήματα Πληροφοριών 

(Μηλιαρέσης, 2006). 
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Σχήμα 1: Η ροή των πληροφοριών σε ένα Γεωγραφικό Σύστημα Πληροφοριών 

 
Πηγή: Καπαγερίδης Ιωάννης, (2010): Εισαγωγή στην Τηλεπισκόπιση και Συστήματα 
Γεωγραφικών Πληροφοριών (Σημειώσεις Θεωρίας), Τ.Ε.Ι. Δυτικής. Μακεδονίας, Τμήμα 
Γωτοχνολογίας και Περιβάλλοντος 

 

 

Κατά τη  διάρκεια των χρόνων πολλοί ερευνητές έχουν διατυπώσει διάφορους 

ορισμούς. Χαρακτηριστικά αναφέρονται οι πιο δεδομένοι:  

 

«Τα Γ.Σ.Π. αντιπροσωπεύουν ένα ισχυρό σύνολο εργαλείων για τη συλλογή, 

αποθήκευση, ανάκτηση κατά βούληση, μετασχηματισμό και εμφάνιση χωρικών 

δεδομένων από τον πραγματικό κόσμο». [Burrough,(1986) από Κουτσόπουλος (2005)] 

«Γεωγραφικό Σύστημα Πληροφοριών είναι μία οργανωμένη συλλογή μηχανικών 

υπολογιστικών μηχανημάτων (hardware), λογισμικών συστημάτων (software), 

χωρικών δεδομένων και ανθρώπινου δυναμικού, με σκοπό τη συλλογή, καταχώρηση, 

ενημέρωση, διαχείριση, ανάλυση και απόδοση, κάθε μορφής πληροφορίας που αφορά 

στο γεωγραφικό περιβάλλον» (Κουτσόπουλος, 2005). 

 

«Γεωγραφικό Σύστημα Πληροφοριών είναι το σύνολο υλικού, λογισμικού, και 

διαδικασιών τι οποίο με την κατάλληλη χρήση υποστηρίζει τη συλλογή, διαχείριση, 

ανάλυση, μοντελοποίηση και παρουσίαση δεδομένων με χωρική αναφορά. Αποτελεί 
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επίσης σημαντικό εργαλείο υποστήριξης λήψεων αποφάσεων στην επίλυση ποικίλων 

προβλημάτων διαχείρισης και σχεδιασμού» (Χαλκιάς., 2006). 

 
 

Η βασική καινοτομία των Συστημάτων Γεωγραφικών Πληροφοριών είναι η 

σύνδεση χωρικών και περιγραφικών πληροφοριών. Σε κάθε ομάδα ομοειδών 

γεωγραφικών πληροφορικών (σημεία, γραμμές ή πολύγωνα) αντιστοιχεί και ένας 

πίνακας περιγραφικών πληροφοριών (attribute table).  

Ειδικότερα, τα Σ.Γ.Π. διαθέτουν ένα μηχανισμό με τον οποίο κάθε γεωγραφική 

πληροφορία (σημείο, γραμμή ή πολύγωνο) αντιστοιχεί με μία εγγραφή του πίνακα 

περιγραφικών πληροφοριών και αντίστροφα, όπως φαίνεται παρακάτω: 

 

 
Εικόνα 1: Σύνδεση Χωρικών και Γεωγραφικών Πληροφοριών 

 
Πηγή: Ζήσου Αντώνιος, (2007): Εισαγωγή στα Συστήματα Γεωγραφικών Πληροφοριών 
ArcGIS/ArcView, Εκδόσεις Σταμούλη, Αθήνα 2007 
 
 
 

1.3 Τηλεπισκόπηση 
 
 

Η Τηλεπισκόπηση ορίστηκε επισήμως από την Αμερικανική Εταιρία 

Φωτογραμμετρίας και Τηλεπισκόπησης (ASPRS – American Society for 

Photogrammetry and Remote Sensing) ως εξής: «Η μέτρηση ή συλλογή πληροφοριών 

για κάποια ιδιότητα ενός αντικειμένου ή φαινομένου μέσω κάποιου οργάνου 

καταγραφής το οποίο δε βρίσκεται σε άμεση επαφή με το υπό μελέτη αντικείμενο ή 

φαινόμενο» [Colwell, (1983) από Καραθανάση (2012)]. 
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Σχήμα 2: Τηλεπισκόπηση 

Πηγή: Πετρόπουλος, (2013): Τηλεπισκόπηση (Σημειώσεις Θεωρίας), Γεωπονικό Πανεπιστήμιο 
Αθηνών, Τμήμα Αξιοποίησης Φυσικών Πόρων & Γεωργικής Μηχανικής 

 

Η τηλεπισκόπηση συνδυάζεται αρμονικά με άλλες επιστήμες Συστημάτων 

Γεωγραφικών Πληροφοριών (GISience) (Γεωεπιστήμες) που περιλαμβάνουν τη 

χαρτογραφία, την τοπογραφία και τα Συστήματα Γεωγραφικών Πληροφοριών (GIS) 

(Καραθανάση, 2012). 

 
 
 
1.4 Εφαρμογές Σ.Γ.Π. και Τηλεπισκόπησης 
 

 
Τα Συστήματα Γεωγραφικών Πληροφοριών και η Τηλεπισκόπηση, ως 

τεχνολογίες οι οποίες δίνουν απαντήσεις σε προβλήματα διαχείρισης του χώρου, 

χρησιμοποιούνται σε πολλαπλά πεδία εφαρμογών από επιχειρήσεις, πανεπιστήμια, 

κυβερνητικούς οργανισμούς και ιδιώτες σε ποικίλες εφαρμογές. 

Οι εφαρμογές αυτές μπορούν να ταξινομηθούν στις εξής κατηγορίες: 

 

o Περιβαλλοντικές εφαρμογές: μελέτη της ατμόσφαιρας και του κλίματος, 

μετεωρολογία, υδρολογία, μελέτη της βλάστησης, αντιμετώπιση φυσικών και 
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τεχνολογικών καταστροφών, μελέτη της κάλυψης γης και των χρήσεων γης, 

γεωλογία, γεωμορφολογία 

 

o Κοινωνικο-οικονομικές εφαρμογές: κτηματολόγιο, εφαρμογές στην 

εγκληματολογία, εφαρμογές ανάλυσης αγοράς, δίκτυα κοινής ωφέλειας κ.ά. 

 

o Διαχειριστικές εφαρμογές: μεταφορές, τοπική αυτοδιοίκηση, χωροταξικός - 

πολεοδομικός σχεδιασμός, κ.ά. 

 
 
 
1.5 Εφαρμογές Σ.Γ.Π. και Τηλεπισκόπησης σε περιβαλλοντικά 
θέματα 
 
 

Μέσω λοιπόν της επιστήμης της Τηλεπισκόπησης μπορούν να 

χρησιμοποιηθούν υψηλής διακριτικής ανάλυσης δορυφορικές εικόνες ούτως ώστε να 

καταγραφούν οι πυρκαγιές, οι πλημμύρες αλλά και άλλα καταστροφικά φαινόμενα.  

Η Τηλεπισκόπηση παρέχει τη δυνατότητα μιας αποτελεσματικής καταγραφής 

της ποιότητας της βλάστησης (Εικόνα 2) μέσα από τις κατάλληλες τεχνικές, όπως 

επίσης παρατηρήσεις των θερμοκρασιακών μεταβολών του εδάφους, παρέχοντας τη 

δυνατότητα σε ειδικούς να εκτιμήσουν τους κινδύνους και να προτείνουν μέτρα.  
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Εικόνα 2: Δείκτης βλάστησης NDVI 

Πηγή: http://www.geoscience-environment.com/ge810/ndvi.html, 20/08/2014 

 
Επίσης, με λήψεις δορυφορικών εικόνων σε τακτά χρονικά διαστήματα 

μπορούν να καταγραφούν, αλλά και να παρακολουθηθούν στενά παράνομες ή και όχι 

οικιστικές δραστηριότητες σε δασικές εκτάσεις. Μέσω αυτής της διαδικασίας μπορεί 

να υπάρξει ένα σύστημα ελέγχου αλλά και προειδοποίησης για κάθε περιοχή που 

παρατηρούνται καταστροφικές δραστηριότητες.  

Συμπερασματικά με τη χρήση δορυφορικών εικόνων είναι δυνατή η διαχρονική 

μελέτη δυναμικά εξελισσόμενων φαινόμενων, όπως η εξέλιξη της βλάστησης, των 

πλημμυρών και των πυρκαγιών. 

http://www.geoscience-environment.com/ge810/ndvi.html
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1.6 Λίγα λόγια για την αναβλάστηση 
 

Τα φυτικά είδη στις ξηρές περιοχές του κόσμου έχουν αναπτύξει πολλούς 

μηχανισμούς προσαρμογής στη φωτιά. Τα μεσογειακά οικοσυστήματα συνήθως 

αναγεννιόνται επαρκώς μετά την πυρκαγιά.  

Τα φυτικά είδη αποκαθίστανται είτε με αναβλάστηση ή με φύτρωμα σπόρων ή 

και με τους δύο τρόπους. Η βλάστηση, σε περιοχές που επικρατούν φυτά από 

αναβλάστηση καλύπτει γρηγορότερα το έδαφος σε σχέση με περιοχές που η 

βλάστηση αναγεννήθηκε με το φύτρωμα σπόρων και συνεπώς προσφέρεται 

μεγαλύτερη προστασία του εδάφους (Vallejo, 2008).  

Η αντίδραση όμως των δέντρων με αναβλάστηση εξαρτάται από πολλούς 

παράγοντες όπως η  εποχή της φωτιάς, η ηλικία του δένδρου, η θρεπτική του 

κατάσταση, η έκταση της ζημιάς κ.ά. Για τους λόγους αυτούς ο προσδιορισμός του 

χρόνου αναβλάστησης και κατ' επέκταση του βαθμού της ζημιάς είναι δύσκολο να 

προσδιοριστεί άμεσα.  

 
 
 
1.7 Παράγοντες αναβλάστησης 
 

Για την καμένη  περιοχή της Πάρνηθας, έγινε εκτενή βιβλιογραφική έρευνα για 

να διερευνηθεί ποιοι παράγοντες μεμονωμένοι ή συνδυαστικά  επηρεάζουν  την 

αναβλάστηση στην περιοχή μελέτης μας.  

 

Οι πέντε ομάδες παραγόντων που διερευνήθηκε η επίδρασή τους στην 

αναβλάστηση είναι (Vallejo, 2008): 

• η χλωρίδα 

• το κλίμα 

• η γεωμορφολογία 

• η ανθρώπινη επίδραση  

• η ιστορία της περιοχής 
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Γενικότερα, αυτοί οι πέντε παράγοντες επηρεάζουν την αναβλάστηση, αλλά δεν 

είναι απαραίτητο να ισχύουν και οι πέντε σε κάθε  περιοχή. Για παράδειγμα, στην 

αναβλάστηση της ελάτης και της πεύκης, η βλάστηση αποτελείται σχεδόν μόνο από 

αυτά τα δύο είδη και δεν διαδραματίζει σημαντικό ρόλο η βροχόπτωση, (οι λόγοι 

αναφέρονται στο επόμενο  κεφάλαιο), (Αμοργιανιώτης, 1999). 

Για την καμένη περιοχή της Πάρνηθας μελετήθηκαν εδαφολογικά στοιχεία -

γεωλογική σύνθεση της  περιοχής, η υδρολογία, το κλίμα και η βλάστηση.  

Βάσει λοιπόν της βιβλιογραφικής έρευνας, καταλήξαμε στη χρήση των 

παρακάτω παραγόντων για την περιοχή μελέτης μας: 

 

i. Υψόμετρο 

ii. Κλίση  

iii. Έκθεση 

iv. Ηλιακή Ακτινοβολία 

v. Απόσταση από υδρογραφικό δίκτυο 

vi. Απόσταση από οδικό δίκτυο 

vii. Χρήσεις γης 

 

Στην ενότητα 2.3 αναλύονται διεξοδικά οι λόγοι για τους οποίους επιλέχθηκαν οι 

συγκεκριμένοι παράγοντες αναβλάστησης της περιοχής μελέτης μας.  

 
 
 
1.8 Η συμβολή των Γ.Σ.Π. και της Τηλεπισκόπησης στην πρόβλεψη 
της αναβλάστησης 
 
 

Οι δασικές πυρκαγιές είναι ένα πολύπλοκο φυσικό φαινόμενο το οποίο 

επηρεάζεται από τους παράγοντες τοπογραφία, καιρικές συνθήκες και καύσιμη ύλη. 

Τοιουτοτρόπως, η αναγκαιότητα για σύγχρονες τεχνικές στη διαχείριση των δασικών 

πυρκαγιών, όσον αφορά στην αποτελεσματική απόκτηση, ανάλυση και έκθεση 

χωρικών πληροφοριών, σε λιγότερο χρόνο και με λιγότερο κόστος, έφερε στο 

προσκήνιο τη χρήση της Τηλεπισκόπησης και  των Γεωγραφικών Συστημάτων 

Πληροφοριών.  
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Τα διαχρονικά χαρακτηριστικά των δορυφορικών δεδομένων επιτρέπουν στους 

διαχειριστές πυρκαγιών τη βελτίωση των γνώσεων τους σχετικά με τις επιπτώσεις 

στη βλάστηση αμέσως μετά την πυρκαγιά. 

Αποτελέσματα ταξινόμησης δορυφορικών δεδομένων που λήφθηκαν πριν τη 

φωτιά, σε συνδυασμό με αυτά μετά τη φωτιά (περίμετρος της καμένης επιφάνειας) 

παρέχουν χωρικές και ποσοτικές πληροφορίες σχετικά με τις ζημιές ανά δασοπονικό 

τύπο, είδος κ.λπ. (Karreris and Kritikos, 1992, Camacho, 1994, από Υπουργείο 

Αγροτικής Ανάπτυξης και Τροφίμων, 2001). 

Η λήψη υψηλής διακριτικής ικανότητας δορυφορικών δεδομένων, αμέσως μετά 

την πυρκαγιά, επιτρέπει τον εντοπισμό της υγιούς βλάστησης εντός της καμένης 

επιφάνειας (Gitas, et al., 2012). 

Τα φασματικά κανάλια στο ορατό και υπέρυθρο, δίνουν τη δυνατότητα 

παρακολούθησης των επιπτώσεων της πυρκαγιάς αλλά και της αναβλάστησης σε μια 

περιοχή (Καρτάλης και Φείδας, 2006). 

Τέτοιες πληροφορίες συνήθως δεν συλλέγονται με τις κλασικές επίγειες 

διαδικασίες, κυρίως εξαιτίας του τρόπου με τον οποίο γίνεται η καταγραφή. Έτσι τα 

δορυφορικά δεδομένα παρέχουν ένα πλήθος πληροφοριών, οι οποίες δεν είναι 

διαθέσιμες στους κλασικούς χάρτες των καμένων επιφανειών.  

Πολλές μελέτες έχουν γίνει αναφορικά με την επίδραση και την ανάλυση της 

επίδρασης της πυρκαγιάς καθώς και τη μελέτη του ρυθμού αναβλάστησης 

πυρόπληκτων οικοσυστημάτων, π.χ. στη λεκάνη της Μεσογείου (Petropoulos et al., 

2010,  Vila and Pablo, 2007,  από Ξενούλης, 2011). 

Ο Chuvieco, το 1995, με σκοπό να εξηγήσει γιατί απαιτείται πιο λεπτομερειακή 

χαρτογράφηση και περιγραφή καμένων εκτάσεων επισήμανε δύο λόγους, οι οποίοι 

συνδέονται με τη δομή των Μεσογειακών τοπίων.  

Ο πρώτος λόγος αναφέρεται στη χωρική συνύπαρξη της δασικής και γεωργικής 

γης, η οποία κάνει την εκτίμηση των καμένων εκτάσεων δύσκολη και ο δεύτερος 

αναφέρεται στη σύνθετη δομή και πολύπλοκη σύνθεση του Μεσογειακού τοπίου.  

Αναφορικά με το δεύτερο γνώρισμα, οι δασικές πυρκαγιές στη Μεσογειακή 

Λεκάνη διαδραματίζουν έναν ιδιαίτερο ρόλο, ως ένα φυσικό φαινόμενο το οποίο 

σχετίζεται με την ύπαρξη συγκεκριμένων τύπων βλάστησης. όπως π.χ πυρόφιλα 

οικοσυστήματα (Chandler et al., 1983), αλλά και ως ένα διαχειριστικό εργαλείο, το 

οποίο χρησιμοποιείται στη γεωργία και κτηνοτροφία για μετατροπή της δασικής γης 

σε άλλες χρήσεις γης (Pereira et al., 1997). 
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Όμως ανεξάρτητα της αιτίας και του σκοπού, η πλειονότητα των δασικών 

πυρκαγιών σχετίζεται άμεσα ή έμμεσα με ανθρώπινες δραστηριότητες και ενέργειες, 

ενώ φυσικοί λόγοι, όπως είναι οι κεραυνοί, αποτελούν ελάχιστο ποσοστό. Αυτός ο 

ιδιαίτερος χαρακτήρας των Μεσογειακών δασικών πυρκαγιών, ιδιαίτερα όταν αυτές 

χρησιμοποιούνται ως ένα διαχειριστικό εργαλείο για τη μακροπρόθεσμη ή 

βραχυπρόθεσμη μετατροπή του τοπίου, απαιτεί τη λεπτομερειακή χαρτογράφηση και 

περιγραφή των καμένων εκτάσεων, έτσι ώστε να εξασφαλιστεί η καλύτερη 

κατανόηση του προβλήματος και επίσης να βελτιωθούν οι ενέργειες πρόληψης και 

προστασίας. 

 

 

 
1.8 Μοντέλα αναβλάστησης 

 
Η μακρόχρονη έκθεση των οικοσυστημάτων στη φωτιά έχει επάγει την 

ανάπτυξη και εξέλιξη ειδικών προσαρμογών απέναντι στη διαταραχή αυτή.  Η 

αυξανόμενη ανθρώπινη δραστηριότητα και επέμβαση του ανθρώπου στα 

οικοσυστήματα αυτά προκαλεί σημαντική επίδραση στα Μεσογειακά τοπία και τα 

οικολογικά τους συστήματα (Αριανούτσου – Φαραγγιτάκη, 2008). 

Κατά συνέπεια, είναι αδύνατον να διαχειριστούμε τα τοπία και τα συστήματα 

αυτά χωρίς να πάρουμε υπόψη μας τα χαρακτηριστικά των φυτών που ενδιαιτούν σε 

αυτά. Η διαχείριση αυτή μπορεί να αποβλέπει στην ελαχιστοποίηση των 

καταστρεπτικών αποτελεσμάτων που μπορεί να έχει η φωτιά, στη διατύπωση 

ορθολογιστικών μεθόδων αποκατάστασης των καμένων εκτάσεων, ακόμη και στην 

ελαχιστοποίηση του κινδύνου έναρξης και εξάπλωσης πυρκαγιάς (Αριανούτσου – 

Φαραγγιτάκη, 2008). 

Τα μοντέλα, αποδεικνύονται ιδιαίτερα χρήσιμα εργαλεία στη διαδικασία της 

υποστήριξης λήψης αποφάσεων. 

Στο εξωτερικό, έχουν δημοσιευτεί αρκετές έρευνες, οι οποίες μελετούν την 

πρόβλεψη της αναβλάστησης με τη χρήση χωρικών μοντέλων. Κατά τη διαδικασία 

της βιβλιογραφικής έρευνας παρατηρήθηκαν ορισμένες ομοιότητες. Οι ομοιότητες 

αυτές είναι οι εξής: 
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o Σχεδόν σε όλες τις δημοσιευθείσες μελέτες χρησιμοποιήθηκαν δορυφορικές 

εικόνες Landsat TM. Ενδεικτικά αναφέρουμε: Xiao, Biradar, Wang, Sheldon, 

Chen, 2011;, Torok-Oance,R. & Torok-Oance,M., 2012;, Hudak, Robichaud, 

Evans, Clark, Morgan, 2007, κ.ά.. 

 

Γνωρίζουμε ότι η χαρτογράφηση μίας καμένης έκτασης με τη χρήση 

τηλεπισκόπησης, γίνεται κυρίως με τις μετρήσεις των αλλαγών στην ανάκλαση της 

ακτινοβολίας των επίγειων αντικειμένων μετά τη φωτιά που συμβαίνουν κυρίως στο 

εύρος του ηλεκτρομαγνητικού φάσματος (0.45 - 3 μm). Ακόμη, η χωρική διακριτική 

ικανότητα στα κανάλια του Landsat είναι 30 Χ 30 μέτρα. Μία εικόνα Landsat 

καλύπτει περίπου μια περιοχή 180 Χ 180 χιλιόμετρα. Αυτή η ανάλυση, δίνει τη 

δυνατότητα στον ερευνητή να έχει μία ολοκληρωμένη εικόνα ενός μεγάλου τμήματος 

του τοπίου και να μπορεί να καταγράψει για παράδειγμα, τις αλλαγές στη βλάστηση. 

(Φείδας  και Καρτάλης,2006)  

  

 

o Ο δείκτης βλάστησης φυλλικής επιφάνειας NDVI επίσης, έχει χρησιμοποιηθεί 

σχεδόν σε όλες τις μελέτες που αφορούν την πρόβλεψη της αναβλάστησης. 

Ενδεικτικά, αναφέρουμε: (Hamel, Garel, Gaillard, 2009),  (Mutanga Savious, 

2007),  (Kassa, 1999), κ.ά. 

 

Υπάρχουν πολλοί δείκτες που αφορούν την βλάστηση πέραν του NDVI, όπως 

οι EVI, SAVI, ARVI κ.ά.. Απλά ο δείκτης NVDI είναι ο κύριος δείκτης 

κανονικοποιημένης βλάστησης, ενώ οι υπόλοιποι δείκτες αφορούν τη βλάστηση 

εξετάζοντας κυρίως όμως και κάποιους άλλους παράγοντες όπως το έδαφος ή το 

νερό. 

 

 

o Όσον αφορά τα μοντέλα πρόβλεψης της αναβλάστησης, έχουν εφαρμοσθεί 

πολλοί μέθοδοι, όπως Λογιστική Παλινδρόμηση, Γραμμική Παλινδρόμηση, 

Γεωγραφικά Σταθμισμένη Παλινδρόμηση, κ.ά. 

 

Σε αυτό το σημείο, να αναφέρουμε ότι δεν υπάρχει κάποια ροή εργασιών - 

διαδικασία, η οποία να είναι όμοια σε κάθε έρευνα. Δηλαδή, δεν υπάρχει κάποια 
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συγκεκριμένη μέθοδο που ακολουθεί ο κάθε ερευνητής. Αντίθετα, ο κάθε ερευνητής 

ανάλογα με την περιοχή μελέτης του και τα δεδομένα που κατέχει ακολουθεί τη 

μέθοδο που πιστεύει ότι θα τον οδηγήσει στη διεξαγωγή ασφαλών συμπερασμάτων. 

Πιο συγκεκριμένα, υπάρχουν μελέτες, στις οποίες διεξάγεται έρευνα με τη 

χρησιμοποίηση μόνο των δεικτών NDVI, για την πρόβλεψη της αναβλάστησης 

(Indeje, Ward, 2006). Άλλες έρευνες, χρησιμοποίησαν ως μέθοδο για την ανάπτυξη 

του μοντέλου τη Λογιστική Παλινδρόμηση (Ηe, Zhou, Zhu, 2003), άλλες τη 

Γραμμική Παλινδρόμηση (Attua, 2008) και άλλες τη Γεωγραφικά Σταθμισμένη 

Παλινδρόμησης  (Usman, et al., 2013). 

Μελετώντας τις παραπάνω έρευνες, αλλά και πολλές άλλες, διαπιστώσαμε ότι 

τα αποτελέσματα των ερευνών δεν ήταν το ίδιο ασφαλή. Για την ακρίβεια, 

παρατηρήθηκε ότι έρευνες οι οποίες, χρησιμοποίησαν Γεωγραφικά Σταθμισμένη 

Παλινδρόμηση, παρουσίαζαν πιο ασφαλή συμπεράσματα από τις άλλες μεθόδους. 

Αυτό, είναι λογικό καθώς συμπεριλαμβάνεται και ο παράγοντας της χωρικής 

διάστασης στο μοντέλο πρόβλεψης.  

Τοιουτοτρόπως, αποφασίστηκε στη συγκεκριμένη διπλωματική μελέτη να 

χρησιμοποιηθεί Γραμμική Παλινδρόμηση και κατόπιν Γεωγραφικά Σταθμισμένη 

Παλινδρόμηση, για να ελεγχθούν τα αποτελέσματα των δύο μεθόδων και ουσιαστικά, 

να συμπεράνουμε πόσο η χωρική διάσταση επηρεάζει το μοντέλο για την πρόβλεψη 

της αναβλάστησης.  

Σε παρακάτω ενότητα περιγράφονται και αναλύονται τα αποτελέσματα των δύο 

μεθόδων.  
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ΕΝΟΤΗΤΑ 2: ΥΛΙΚΑ ΚΑΙ ΜΕΘΟΔΟΙ 

 
 
2.1 Γεωγραφική θέση περιοχής μελέτης 
 

Η Πάρνηθα είναι μεγάλο ορεινό συγκρότημα με διεύθυνση από Ανατολάς προς 

Δυσμάς, που μόνο δυτικά ενώνεται με το όρος Πάστρα (1076μ.) και το οροπέδιο των 

Σκούρτων (μέσο υψόμετρο 550 μ).   

Μπορεί να χωριστεί σε τρία μεγάλα τμήματα, ήτοι την Βόρεια, την Κεντρική 

όπου βρίσκονται οι ψηλότερες κορφές και την Δυτική Πάρνηθα. Πρόκειται για 

εκτεταμένο βουνό με δεκάδες κορυφές, χαράδρες, ρεματιές και οροπέδια, που στο 

μεγαλύτερο μέρος του είναι δασωμένο. Παρουσιάζει πολύ μεγάλη ποικιλομορφία 

στην δομή του, που ικανοποιεί τόσο τον απλό πεζοπόρο, όσο και τον εξασκημένο 

ορειβάτη και τον αναρριχητή.   

Η πλούσια χλωρίδα του με 815 εξακριβωμένα είδη και η άφθονη πανίδα που 

αριθμεί 132 είδη πουλιών, 45 είδη θηλαστικών με κυριότερο εκπρόσωπο το ελάφι 

(Cervus elaphus) και 30 είδη ερπετών και αμφίβιων, προσφέρει το μέγιστο πεδίο 

επιστημονικής έρευνας και δράσης.  

 
Χάρτης 2.1: Πάρνηθα 

Πηγή: el.wikipedia.org, 29/09/2014 

 

http://el.wikipedia.org/wiki/%CE%A0%CE%AC%CF%81%CE%BD%CE%B7%CE%B8%CE%B1
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Οι ομαλές πλαγιές συνέχονται με μικρά οροπέδια, λιβάδια, όμορφες κοιλάδες 

και λάκες που κατακερματίζονται σε πολλά σημεία από μεγάλες και βαθιές χαράδρες, 

ρέματα και φαράγγια (Ρέμα Γκούρας - Γιαννούλας). Οι κορυφές στην Πάρνηθα είναι 

γενικά ομαλές, υπάρχουν όμως και απόκρημνες, βραχώδεις κορυφογραμμές 

(Καραβόλα, Φλαμπούρι, Μαυροβούνι, Αρμα κτλ.). Είναι το μεγαλύτερο σε έκταση 

και ψηλότερο βουνό της Αττικής.  

Ένα από τα σημαντικότερα στοιχεία που συνθέτουν τη περιοχή μελέτης, είναι ο 

χαρακτηρισμός της σε Εθνικό Δρυμό, όπου καταλαμβάνει έκταση περίπου 200.000 

στρεμμάτων. Επιπροσθέτως έχει ενταχθεί στο δίκτυο Natura 2000, εξαιτίας της 

ιδιαίτερης βιοποικιλότητας, ενώ αποτελεί σημαντική περιοχή για πολλά σπάνια είδη 

άγριων ζώων και πτηνών. 

 
 
 
2.2 Πυρκαγιά 2007 

Από το 1913 έως το 1998 σημειώθηκαν 393 πυρκαγιές στην υπό μελέτη 

περιοχή της Πάρνηθας και κάηκαν συνολικά 243.581 στρ. δασών και δασικών 

εκτάσεων, σε συνολική έκταση της περιοχής 230.000 στρ. περίπου. Συγκεκριμένα, 

κάθε περιοχή κάηκε από 1 έως 6 φορές.  

 

 
Εικόνα 2.1: Καμένη έκταση στην Πάρνηθα 

Πηγή: www.parnitha-np.gr/, 09/09/2014 
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Η καμένη έκταση ξεκινά από τις δυτικές υπώρειες της Πάρνηθας, πάνω από το 

οροπέδιο των Σκούρτων και φτάνει στη χαράδρα Χούνη (περιοχή Θρακομακεδόνων) 

καλύπτοντας μια έκταση που ξεπερνά σε μήκος τα 15 χλμ. και καλύπτεται κυρίως 

από πευκοδάση και ελατοδάση. Το τοπίο του καμένου πευκοδάσους παρουσιάζει 

ετερογένεια, καθώς συνυπάρχουν θέσεις άκαφτες με θέσεις στις οποίες η φωτιά είχε 

είτε μέτρια (τα πεύκα διατηρούν καψαλισμένο φύλλωμα) είτε μεγάλη ένταση (τα 

πεύκα διατηρούν μόνο καμένους κορμούς και λίγα κλαδιά). Στα χαμηλά υψόμετρα η 

φωτιά έκαψε κυρίως εκτάσεις με πευκοδάση.  

Το αποτέλεσμα της πυρκαγιάς ήταν στην Πάρνηθα το καλοκαίρι του 2007, 

ήταν η καταστροφή 36.338 στρεμμάτων στον Εθνικό Δρυμό της Πάρνηθας από τα 

οποία τα 21.800 ήταν δάσος κεφαλληνιακής ελάτης. 
 

 

 

  

 Πριν τη Φωτιά της 28/06/2007       Μετά τη Φωτιά της 28/06/2007 

Εικόνες 2.2 & 2.3: Εθνικός Δρυμός Πάρνηθας 

Πηγή: http://www.parnitha-np.gr/, 05/09/2014 

 
 
 

Γενικότερα να αναφερθεί ότι ο κίνδυνος πυρκαγιάς είναι εντονότερος στα 

χαμηλά υψόμετρα όπου κυριαρχεί η χαλέπιος πεύκη και τα αείφυλλα σκληρόφυλλα, 

ενώ υψηλότερα, όπου επικρατεί η ελάτη, ο κίνδυνος περιορίζεται αισθητά. Αυτό 

οφείλεται κυρίως στο ότι η ελάτη εμφανίζεται πάνω από τα 800μ όπου η διάρκεια της 

ξηρής θερινής περιόδου και ο αριθμός των βιολογικά ξηρών ημερών είναι 
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μικρότερες, η μέση θερμοκρασία του αέρα είναι περίπου 6ο C χαμηλότερη στις 

κορυφογραμμές και η πίεση για οικιστική ανάπτυξη μηδενική. 

 
 
2.3 Παράγοντες Αναβλάστησης  
 

Στην ενότητα αυτή παρουσιάζονται στοιχεία σύμφωνα με τη Διαχειριστική 

Μελέτη του 1999, την οποία δημοσίευσε το Δασαρχείο της Πάρνηθας και τα 

στοιχεία, τα οποία παρέθεσε στη δημοσιότητα η Γενική Διεύθυνση Ανάπτυξης και 

Προστασίας Δασών και Φυσικού Περιβάλλοντος του Υπουργείου Αγροτικής 

Ανάπτυξης και Τροφίμων σε συνεργασία με το Εθνικό Ίδρυμα Αγροτικής Έρευνας 

(ΕΘ.Ι.ΑΓ.Ε.). 

 

Επίσης, σε αυτή την ενότητα δίνεται έμφαση στους λόγους για τους οποίους 

επιλέχθηκαν οι παράγοντες που αναφέραμε στην προηγούμενη ενότητα. 

 

 
Εδαφολογικά στοιχεία  
 

Το έδαφος μαζί με το κλίμα καθορίζουν την εξάπλωση και ανάπτυξη των 

διαφόρων φυτικών ειδών μιας περιοχής. Επίσης, η καταλληλότητα και η αντοχή της 

γης στις διάφορες χρήσεις εξαρτώνται, σε μεγάλο βαθμό, από τις ιδιότητες του 

εδάφους. Οι παράγοντες που επηρεάζουν την εδαφογένεση είναι:  

• Το μητρικό πέτρωμα που προμηθεύει το υλικό για το έδαφος που 

δημιουργείται από την διάβρωσή του 

• Το κλίμα 

• Η βλάστηση 

Οι παράγοντες αυτοί μετασχηματίζουν και διασκευάζουν το προαναφερόμενο 

υλικό. Στον ορεινό όγκο της Πάρνηθας τα μητρικά πετρώματα που κυριαρχούν είναι 

οι σκληροί ασβεστόλιθοι και οι σχιστόλιθοι. Τα εδάφη που εμφανίζονται πάνω στα 

πετρώματα αυτά είναι γενικά πολύ αβαθή, έντονα διαβρωμένα, ασυνεχή - 

διακοπτόμενα, δηλαδή, από την εμφάνιση του μητρικού πετρώματος.  

Βαθύτερα εδάφη παρατηρούνται μόνο σε ορισμένες θέσεις, εκεί όπου 

ενήργησαν προστατευτικά. Τέτοιες θέσεις είναι ορισμένα καρστικά πλατώματα και 
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βυθίσματα, όπως αυτά της Ντράσιζας, της Μόλας, της Σαλονίκης, του Λοιμικού, του 

Ξερολίβαδου κ.α., που είναι φυσικά λιβάδια με ποώδη βλάστηση. 

Η Πάρνηθα αποτελείται από ιζηματογενή πετρώματα που σχηματίστηκαν 

περίπου 1 έως 70 εκατομμύρια χρόνια πριν από την εποχή μας. Τα κυριότερα από 

αυτά είναι σχιστόλιθοι και ασβεστόλιθοι. Οι σχιστόλιθοι γενικά παρατηρούνται στις 

χαράδρες και στις κοιλάδες του βουνού και οι ασβεστόλιθοι στις κορυφές του, ενώ 

εμφανίζεται και λίγος φλύσχης. 

Επιπροσθέτως, στον Εθνικό Δρυμό. της Πάρνηθας μπορεί κανείς εύκολα να 

αντιληφθεί τον βαθμό της επίδρασης των τεκτονικών κινήσεων καθώς επίσης την 

εξάρτηση των διαφόρων γεωμορφολογικών στοιχείων του Ε.Δ. από τις κινήσεις 

αυτές. Το πλήθος των ρηγμάτων, οι πολλές μετακινήσεις, οι μεταπτώσεις, οι 

πτυχώσεις και διάφορα άλλα φαινόμενα μαρτυρούν την έκταση της τεκτονικής 

δράσης στην περιοχή καθώς και τον βασικό ρόλο της δράσης αυτής στον σχηματισμό 

του ορεινού ανάγλυφου.  

Τα αποτελέσματα των τεκτονικών κινήσεων ήταν κάθε φορά διαφορετικά και 

εξαρτώμενα τόσο από την ένταση των κινήσεων όσο και από την φύση των 

πετρωμάτων πάνω στα οποία αυτές επέδρασαν.  

Δεν θα πρέπει να αγνοηθεί το γεγονός ότι οι σημερινές θέσεις των γεωλογικών 

σχηματισμών είναι διαφορετικές από τον χώρο σχηματισμού τους λόγω των μεγάλων 

μετακινήσεων που έχουν συμβεί στη διάρκεια των πολλών εκατομμυρίων χρόνων 

που μεσολάβησαν.  

Οι μετακινήσεις αυτές οφείλονται κατά κύριο λόγο στην κίνηση των 

λιθοσφαιρικών πλακών, στις μεταξύ τους συγκρούσεις καθώς και στις αποκλίσεις 

τους. Στην περιοχή της Πάρνηθας δεν υπάρχουν ενεργά ρήγματα.  

Από μορφογενετική άποψη μεγαλύτερη σημασία έχουν οι ορογενετικές 

κινήσεις χωρίς να παραγνωρίζονται όμως και οι ηπειρογενετικές, οι οποίες 

συνεχίζουν μέχρι και σήμερα να δρουν στην περιοχή. 

 

 

Υδρολογία 
 

Αναφορά, πρέπει να γίνει και στα επιφανειακά ύδατα τα οποία επηρεάζουν την 

ανάπτυξη της βλάστησης. Τα επιφανειακά ύδατα στον Εθνικό Δρυμό Πάρνηθας 
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ξεκινούν από την περιοχή των υψηλότερων κορυφών και διαρρέουν την μεγαλύτερη 

περιοχή του πυρήνα με την μορφή εποχιακών ρεμάτων. Αυτά την περίοδο 

φθινοπώρου - χειμώνα αποκτούν χειμαρρώδη ροή.  

Τα ύδατα των ρεμάτων αυτών είναι συνήθως διαυγή γιατί τόσο στις λεκάνες 

απορροής τους υπάρχει δασοκάλυψη όσο και κατά μήκος της κοίτης τους απαντάται 

βλάστηση.  

 

 

 

 

Εικόνα 2.4: Το Μαυρόρεμα στις βορειοδυτικές περιοχές του Δρυμού 
Πηγή: www.parnitha-np.gr/,19/08/2014 

 

Τα κυριότερα από τα ρέματα είναι της Μονής Κλειστών, της Αγίας Τριάδας, 

της Χούνης, της Μόλας, το Μαυρόρεμα, του Αγίου Μερκουρίου - Σφενδάλης, του 

Αγίου Γεωργίου κ.α. 

Η διάταξη των πετρωμάτων στην Πάρνηθα ευνοεί τη δημιουργία πολλών 

πηγών. Στα σημεία όπου συναντώνται ο ασβεστόλιθος (αφήνει το νερό να περνά από 

μέσα του) με τον σχιστόλιθο (δεν επιτρέπει στο νερό να περάσει), το νερό βγαίνει 

στην επιφάνεια με τη μορφή πηγής.  

http://www.parnitha-np.gr/,19/08/2014


 24 

Στην Πάρνηθα έχουν καταγραφεί 45 πηγές συνεχούς ροής, ενώ πολύ γνωστή 

είναι η πηγή της Κιθάρας, που τροφοδοτούσε από την αρχαιότητα μέχρι σήμερα το 

Αδριάνειο υδραγωγείο, το οποίο περνώντας κάτω από τον Κηφισό, μεταφέρει το νερό 

της Πάρνηθας στη δεξαμενή του Κολωνακίου. Άλλες γνωστές πηγές είναι της Αγ. 

Τριάδας, της Μόλας, της Σκίπιζας και της Κορομηλιάς.  

Ποταμοί με συνεχή ροή δεν υπάρχουν στο βουνό, αλλά υπάρχουν πολλά 

εποχιακά ρέματα, το νερό των οποίων είναι διαυγές, γιατί η Πάρνηθα σκεπάζεται με 

βλάστηση που προστατεύει το έδαφος από τη διάβρωση. Τα κυριότερα ρέματα είναι 

της Αγ. Τριάδας, της Χούνης, της Μόλας, του Κελάδωνα, του Αγ. Γεωργίου και το 

Μαυρόρεμα. 

 

 

Κλίμα  
Η περιστασιακή μόνο λειτουργία του μετεωρολογικού σταθμού Πάρνηθας και 

του δάσους Τατοΐου είχε σαν αποτέλεσμα τα στοιχεία για το κλίμα και τα 

μετεωρολογικά φαινόμενα στον κυρίως ορεινό όγκο της Πάρνηθας να είναι 

περισσότερο ενδεικτικά παρά απόλυτα. 

Σημαντικές διευκρινήσεις για το κλίμα του ορεινού όγκου παρέχονται επίσης 

από ανθρώπους που διαβιούν για μεγάλο χρονικό διάστημα στο βουνό. Σύμφωνα με 

τις “μαρτυρίες” των ανθρώπων αυτών, το μέγιστο των βροχοπτώσεων στις περιοχές 

άνω των 1.000 μέτρων σημειώνονται από τον Νοέμβριο μέχρι τον Μάρτιο. Το 

καλοκαίρι δεν βρέχει καθόλου. Τους πρώτους φθινοπωρινούς μήνες και τους 

τελευταίους ανοιξιάτικους μήνες οι βροχές είναι σποραδικές.  

Τόσο το φθινόπωρο όσο και το χειμώνα η ομίχλη και ο παγετός είναι συχνά 

φαινόμενα στην Πάρνηθα. 

Από το ομβροθερμικό διάγραμμα του σταθμού του ΙΓΜΕ στην Πάρνηθα, 

προκύπτει ότι το μεγαλύτερο ποσοστό του συνολικού ύψους βροχής στα ορεινά του 

βουνού, οφείλεται σαφώς στις αυξημένες βροχοπτώσεις κατά τους υγρούς μήνες και 

όχι στους θερινούς μήνες. Η ξηρή περίοδος στην κορυφή της Πάρνηθας (ζώνη της 

ελάτης) είναι το ίδιο ξηρή με την περιοχή του αεροδρομίου Τατοΐου.  

Οι θερμοκρασίες που καταγράφονται στα ορεινά της Πάρνηθας είναι σαφώς 

μικρότερες από τις αντίστοιχες θερμοκρασίες των χαμηλών υψομέτρων. Από την 

σύγκριση των μέσων μηνιαίων θερμοκρασιών των σταθμών Α/μίου Τατοΐου 
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(υψόμετρο 234,7 μ.) του δάσους Τατοΐου (υψόμετρο 478 μ.) και του σταθμού της 

Πάρνηθας (υψόμετρο 1020 μ.) προκύπτει ότι η θερμοκρασιακή διαφορά μεταξύ των 

ανωτέρω σταθμών κυμαίνεται μεταξύ 2 και 6 οC. Σε θεωρητικό βέβαια επίπεδο η 

θερμοκρασία του αέρα μειώνεται κατά 6 οC ανά 1.000 μέτρα υψόμετρο. 

Συμπερασματικά η διαφοροποίηση των κλιματικών συνθηκών στην Πάρνηθα 

έχει ως εξής:  

1. Η ανώτερη υψομετρική ζώνη (άνω των 1.000 μ) δέχεται διπλάσιες σχεδόν 

βροχοπτώσεις από τα χαμηλά υψόμετρα (412,9 mm στο αεροδρομίου Τατοΐου έναντι 

789,3 mm στη Πάρνηθα).  

2. Στο ενδιάμεσο ύψος των 500 μ το μέσο ύψος βροχής κατ’ έτος ανέρχεται σε 

640 mm περίπου.  

3. Οι βροχοπτώσεις και στους τρεις σταθμούς είναι άνισα κατανεμημένες κατά 

την διάρκεια του έτους και πέφτουν στην κυρίως υγρή περίοδο (τέλος φθινοπώρου 

έως αρχές άνοιξης).  

4. Η ξηρή περίοδος είναι το ίδιο ξηρή όσον αφορά τις βροχοπτώσεις και στα 

μεγάλα και στα χαμηλά υψόμετρα, διαρκεί όμως περισσότερο στα δεύτερα.  

5. Η μέση θερμοκρασία του αέρα είναι περίπου 6 οC χαμηλότερη στις 

κορυφογραμμές της Πάρνηθας απ’ ότι στους πρόποδες.  

6. Οι χιονοπτώσεις είναι περισσότερες στα ορεινά του βουνού παρά στις 

χαμηλότερες παρυφές του, ο αριθμός τους δε ποικίλλει πολύ από έτος σε έτος.  

7. Κάθε 3 με 4 χρόνια έχουμε μια ξηρή χρονιά στην οποία τα κατακρημνίσματα 

εμφανίζονται μειωμένα σε ποσοστό μέχρι και 40%. 

 
 
 
Βλάστηση  

Σχετικά με τη βλάστηση που αναπτύσσεται στην Πάρνηθα, πρέπει να 

αναφερθεί, ότι οι χαμηλότερες περιοχές του βουνού κάτω από 1.000μ για τις νότιες 

και τα 500μ για τις βόρειες εκθέσεις σκεπάζονται από δάσος χαλεπίου πεύκης και 

θάμνους της Μεσογειακής βλάστησης, όπως το πουρνάρι, το φιλλύκι, η κουμαριά, η 

αγριελιά, η κοκορεβυθιά, το χρυσόξυλο και μεμονωμένα άτομα βελανιδιάς στα 

χαμηλότερα σημεία. Πάνω από 800μ συναντάμε το μοναδικό στην Αττική δάσος 

κεφαλληνιακής ελάτης, που σχηματίζει πυκνές συστάδες και ανήκει στον πυρήνα του 

Εθνικού Δρυμού κατά τα μεγαλύτερο μέρος του.  
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Εικόνα 2.5:  Δασικός χάρτης Πάρνηθας  

Πηγή: www.parnitha-np.gr/, 18/09/2014 
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Πίνακας 2.1: Κατηγορίες δασών και χρήσεις γης 

 
 
 
 
 
 
 
Αναλυτική περιγραφή των παραγόντων της αναβλάστησης  
 

Η έντονη λαθροϋλοτομία και βοσκή κατά το παρελθόν, οι πυρκαγιές που 

κατέστρεψαν σημαντικά τμήματά του καθώς και η επιδημία των εντόμων Gryphalus 

Piceae που συνεχίζεται για 35 χρόνια και ξηραίνει χιλιάδες άτομα ελάτης κάθε χρόνο 

είχε σαν αποτέλεσμα, το δάσος αυτό να έχει τελείως ακανόνιστη δομή και να 

βρίσκεται ακόμα σε οπισθοδρομική εξέλιξη αν και πέρασαν 35 χρόνια από την 
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ίδρυση του εθνικού δρυμού Πάρνηθας και την ένταξή του σε αυστηρό καθεστώς 

προστασίας. 

Η φυσική αναγέννηση της ελάτης στην Πάρνηθα ήταν προβληματική τόσο στο 

παρελθόν όσο και σήμερα. Για το λόγο αυτό ήδη από το 1917 είχε απαγορευτεί η 

βοσκή αιγών στο δάσος αυτό για 10 χρόνια. Το μέτρο αυτό που επαναλήφθηκε με 

μεγαλύτερη αυστηρότητα μετά το 1950 δεν έδωσε σπουδαία αποτελέσματα.  

Ο δασολόγος Δ. Καϊλίδης στις σχετικές έρευνές του για την ξήρανση των 

ελατοδένδρων της Πάρνηθας το 1961 αναφέρει ότι “…….. εις την Πάρνηθαν 

ουδαμού συναντήσαμεν φυσικήν αναγέννησιν”.  

Ο συντάκτης της Α΄ διαχειριστικής έκθεσης του εθνικού δρυμού Πάρνηθας κ. 

Κ. Μακρής το 1961 αναφέρει ότι υπάρχει μεν μεγάλο πρόβλημα αναγέννησης στην 

Πάρνηθα, που οφείλεται σε συνδυασμό πολλών παραγόντων όπως η μεγάλη ηλικία 

των σπορέων, οι ακραίες για την ελάτη κλιματοεδαφικές συνθήκες της Πάρνηθας η 

μακρά κακοποίηση του ελατοδάσους από τους περιοίκους κ.τ.λ., αλλά το πρόβλημα 

αυτό μπορεί να ξεπεραστεί με κατάλληλους δασοκομικούς χειρισμούς.  

 

 
Εικόνα 2.6. Η ζώνη του ελατοδάσους 

Πηγή: http://www.parnitha-np.gr/, 05/09/2014 
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Ενδιαφέρουσα είναι επίσης η παρατήρηση που έγινε κατά την καταγραφή της 

αναγέννησης ότι σε όλες σχεδόν τις περιπτώσεις η αναγέννηση δεν έβγαινε έξω από 

την σκιαζόμενη από την κόμη των μητρικών δένδρων επιφάνεια. 

Πολύτιμα επίσης στοιχεία σχετικά με την αναγέννηση της ελάτης στην 

Πάρνηθα περιέχονται στην διδακτορική εργασία του δασολόγου Λευτέρη 

Σταματόπουλου (Αμοργιανιώτης, 1999). 

 

Σύμφωνα με την εργασία αυτή: 

1. Το ύψος της αναγέννησης της ελάτης καθίσταται μέγιστο όταν το πάχος του 

οργανικού ορίζοντα του εδάφους κυμαίνεται από 1,5 - 2,5 cm και ελάχιστο όταν το 

πάχος αυτό υπερβαίνει τα 3,5 έως 4 cm.  

2. Η αναγέννηση είναι ευθέως ανάλογη με την φαινομενική υγρασία του σταθμού. 

Παρατηρήθηκε εννεαπλάσια σχεδόν αναγέννηση σε υγρό σταθμό έναντι του 

κατάξηρου σταθμού.  

3. Η αναγέννηση εξαρτάται ευθέως από την κάλυψη του σταθμού σε σκληρό 

πέτρωμα. Έτσι όταν το σκληρό πέτρωμα καλύπτει το σταθμό σε ποσοστό 0 - 20% η 

αναγέννηση είναι τετραπλάσια σχεδόν της αντίστοιχης αναγέννησης του σταθμού 

που το σκληρό πέτρωμα καλύπτει το 80 - 100% της επιφανείας του. 

4. Το ύψος της αναγέννησης είναι ανάλογο με την φυτοκάλυψη του εδάφους. Έτσι 

όταν η φυτοκάλυψη (δένδρα και θάμνοι) υπερβαίνει το 75% σε μία επιφάνεια τότε η 

αναγέννηση της ελάτης στην επιφάνεια αυτή είναι εξαπλάσια από την αναγέννηση σε 

αντίστοιχη έκταση που η φυτοκάλυψη δεν υπερβαίνει το 10% . 

5. Επιτυγχάνεται καλή αναγέννηση όταν το pH του χούμου κυμαίνεται από 6 - 7,5 . Η 

καλύτερη αναγέννηση παρατηρήθηκε όταν το pH κυμαίνονταν από 7 - 7,5 ενώ 

υπήρξε δραματική μείωση για pH χούμου 7,5 – 8.  

6. Η καλύτερη αναγέννηση επιτυγχάνεται σε κλίσεις που κυμαίνονται από 10 - 30%. 

Σε κλίσεις πάνω από 40% η αναγέννηση αντιπροσωπεύει το 25% της αντίστοιχης 

μέγιστης αναγέννησης που επιτυγχάνεται σε κλίσεις 10 - 20% . 

7. Η οργανική ουσία του εδάφους επηρεάζει άμεσα το ύψος αναγέννησης. Όταν η 

οργανική ουσία του εδάφους αυξάνεται, αυξάνεται και η επιτυχία της αναγέννησης 

και μεγιστοποιείται όταν η οργανική ουσία κυμαίνεται από 12 -18 mg/kg. Πέραν του 

ορίου αυτού η αναγέννηση μειώνεται δραματικά κατά 80%.  
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8. Η διάβρωση του εδάφους επηρεάζει την πορεία αναγέννησης επίσης. Η 

αναγέννηση στα διαβρωμένα εδάφη αποτελεί μόλις το 30% περίπου της αντίστοιχης 

αναγέννησης των μη διαβρωμένων εδαφών. 

 

Όσον αφορά τη φυσική αναγέννηση στην χαλέπιο πεύκη δεν θα γίνει ιδιαίτερη 

αναφορά καθώς η φυσική αναγέννηση είναι σχεδόν πάντα εξασφαλισμένη γιατί 

καρποφορεί άφθονα και σχεδόν κάθε χρόνο. Ιδιαίτερα μετά από πυρκαγιά η χαλέπιος 

πεύκη αναγεννιέται εύκολα και “επεκτείνει” το χώρο της αρκεί να προστατευτεί από 

την βόσκηση και τις ζημιές της συγκομιδής του ξύλου.  

Αλλά και χωρίς πυρκαγιά οι συστάδες της χαλεπίου πεύκης αναγεννιούνται 

εύκολα. Τα μόνα εμπόδια στην φυσική αναγέννηση είναι ο ανταγωνισμός της 

υπορόφου βλάστησης και της βοσκής. Όταν αρθούν τα εμπόδια αυτά δεν υπάρχει 

πρόβλημα αναγέννησης. Μάλιστα η βοσκή στα υψηλά πευκοδάση ανταγωνίζεται την 

υπόροφη βλάστηση και ευνοείται έτσι η ανάπτυξη του ανωρόφου. 

 

  

Εικόνα 2.7. Η ζώνη του πευκοδάσους 
Πηγή: http://www.parnitha-np.gr/, 05/09/2014 
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Ακόμη, να αναφερθεί ότι στο Δάσος Φυλής που επικρατούν σκελετικά εδάφη, 

οι μεγάλες κλίσεις και οι Α, Ν, ΝΑ και ΝΔ εκθέσεις χρειάστηκαν 12 χρόνια για να 

αποκτήσουν τα φυτά της αναγέννησης ένα μέσο ύψος 0,3 – 0,5 μ και να καλύψουν το 

έδαφος σε ποσοστό πάνω από 80%.  

Επί προσθέτως, όταν έχουμε επιφανειακή εμφάνιση του μητρικού πετρώματος 

και επανειλημμένες πυρκαγιές με χρόνο περιφοράς των πυρκαγιών κάτω από 10 

χρόνια, όχι μόνο δεν έχουμε αναγέννηση της χαλεπίου πεύκης, αλλά και η 

εγκατάσταση των θαμνώνων είναι αραιή και καλύπτουν μικρό μόνο μέρος της 

επιφάνειας. 

 
 
2.4 Δεδομένα 
 
Συλλογή δεδομένων 
 

Για την εκπλήρωση των στόχων της παρούσης εργασίας χρησιμοποιήθηκαν 

δεδομένα διαφορετικών ημερομηνιών λήψης από τον δορυφορικό πολυφασματικό 

δέκτη LANDSAT TM σε συνδυασμό με λοιπά διαθέσιμα δεδομένα εδάφους της 

πιλοτικής περιοχής. 

Περιοχή μελέτης της συγκεκριμένης διπλωματικής εργασίας είναι η περιοχή της 

Πάρνηθας. Χωρικά δεδομένα για τη συγκεκριμένη περιοχή συλλέχθηκαν από την 

Ερευνητική Μονάδα GIS του Τμήματος Αξιοποίησης Φυσικών Πόρων & Γεωργικής 

Μηχανικής του ΓΠΑ. 

 

 

Αναλυτικά τα δεδομένα τα οποία παραλήφθηκαν ήταν τα εξής: 

Έξι επεξεργασμένες δορυφορικές εικόνες του δορυφόρου LANDSAT TM. Τα 

δορυφορικά αυτά δεδομένα, έχουν αποκτηθεί σε κοντινές χρονικά περιόδους μετά 

την πρόκληση της πυρκαγιάς (Petropoulos et al., 2010). Η μία εξ αυτών είχε 

ημερομηνία λήψης πριν τη πυρκαγιά (16/05/2007) και οι υπόλοιπες πέντε μετά την 

πυρκαγιά (03/07/2007, 19/07/2007, 24/07/2009, 12/08/2010, 15/08/2011). Οι εικόνες 

αυτές απεικόνιζαν το δείκτη βλάστησης NDVI για τις συγκεκριμένες χρονικές 

περιόδους, και οι χωρική τους διακριτική ικανότητα είναι 30μ Χ 30μ. 

Η επιλογή των δορυφορικών εικόνων είχε γίνει με διάφορα κριτήρια, όπως: α) 

την απουσία ύπαρξης σύννεφων στην περιοχή μελέτης και β) τη χρονική περίοδο που 
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λήφθηκαν οι εικόνες, ώστε να είναι περίπου τον ίδιο μήνα ή την ίδια εποχή του έτους, 

για τη μείωση διαφορών στη φαινολογία των φυτών, που θα έχουν ως αποτέλεσμα 

διαφοροποιήσεις στη διαδικασία της ταξινόμησης (Ξενούλης, 2011). 

 

Δείκτης Βλάστησης Κανονικοποιημένης Διαφοράς (Normalized Difference 
Vegetation Index - NDVI) 

 
Ο δείκτης NDVI είναι ο λόγος της διαφοράς της ανάκλασης στο κοντινό υπέρυθρο 

(NIR) και στο κόκκινο (Red), που διαιρείται με το άθροισμα αυτών και εφαρμόζεται 

σε δορυφορικά δεδομένα από τους δορυφόρους LANDSAT της NASA. 

 

NDVI = (NIR - Red) / (NIR + Red) 

 

O NDVI μπορεί να πάρει τιμές από «-1» (μηδενική φυτοκάλυψη) μέχρι «+1» (πλήρης 

φυτοκάλυψη). Συνεπώς, οι περιοχές που στερούνται βλάστηση δίνουν μια αρνητική 

τιμή ή μια τιμή κοντά στο μηδέν, σε αντίθεση με μία τιμή NDVI κοντά στο +1, η 

οποία αντιπροσωπεύει πλούσια βλάστηση.   

 

Ο δείκτης NDVI είναι χρήσιμος για τον προσδιορισμό της κατάστασης της 

βλάστησης. Παρουσιάζει τις μεταβολές και την εκτίμηση της βιομάζας (Καρτάλης, 

Φείδας, 2006). 

 

 

Μία εικόνα ASTER DEM η οποία χρησιμοποιείται για τη ψηφιακή αναπαράσταση 

του ανάγλυφου του εδάφους. Η συγκεκριμένη εικόνα απεικόνιζε το υψόμετρο της 

περιοχής μελέτης. Στη συνέχεια το ASTER DEM χρησιμοποιήθηκε για την 

παραγωγή τριών νέων παραμέτρων – κλίση, έκθεση και ηλιακή ακτινοβολία. 

 

Ένα διανυσματικό αρχείο το οποίο απεικονίζει το υδρογραφικό δίκτυο.  

 

Ένα διανυσματικό αρχείο  το οποίο απεικονίζει το οδικό δίκτυο. 

 

Αρχείο Corine 2000, από το επίσημο site www.eea.europa.eu, για την απόκτηση 

πληροφοριών για το είδος βλάστησης κάθε κελιού - ψηφίδας.   
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Χάρτης 2.2: Υδρογραφικό Δίκτυο Πάρνηθας 
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Χάρτης 2.3: Οδικό Δίκτυο Πάρνηθας 

 

 

 

Σε αυτό το σημείο, να επισημάνουμε ότι η επιλογή των παραγόντων για τη 

δημιουργία μοντέλου πρόβλεψης της αναβλάστησης έγινε βάσει βιβλιογραφίας. 

Συγκεκριμένα, για την περιοχή μελέτη μας οι παράγοντες που επιλέξαμε, οι 

οποίοι αναφέρονται στα επόμενα βήματα επηρεάζουν κατά πολύ την αναβλάστηση.  

Η συγκεκριμένη βιβλιογραφική έρευνα μας βοήθησε στην αποφυγή 

χρησιμοποίησης παραγόντων, οι οποίοι δεν θα συνεισέφεραν στο μοντέλο 

πρόβλεψης. Για παράδειγμα, σε αρχικό στάδιο, είχε επιλεχθεί η βροχόπτωση ως μία 

από τις μεταβλητές μας.  

Κάνοντας λοιπόν, βιβλιογραφική έρευνα συμπεράναμε ότι στην αναβλάστηση 

της ελάτης και της πεύκης (η  βλάστηση αποτελείται σχεδόν μόνο από αυτά τα δύο 

είδη), δεν διαδραματίζει σημαντικό ρόλο η βροχόπτωση (οι λόγοι αναφέρονται στο 

προηγούμενο κεφάλαιο).   
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2.5 Μέθοδοι Ανάλυσης 
 
2.5.1 Μέθοδοι μη Χωρικής Στατιστικής  
 

Η επιστημονική έρευνα επιτρέπει στους ερευνητές να προβαίνουν σε 

παρατηρήσεις των φαινομένων και των προβλημάτων που εξετάζουν. Η Στατιστική 

παρέχει τα κατάλληλα εργαλεία για το σχεδιασμό της διαδικασίας συλλογής, 

περιγραφής, ανάλυσης και επεξεργασίας αυτών των παρατηρήσεων. Δηλαδή, ένα 

σύνολο από μεθόδους και κανόνες που επιτρέπουν την οργάνωση μια συλλογής 

δεδομένων, τη συνοπτική και αποτελεσματική παρουσίαση και ανάλυσή τους, και 

τέλος την εξαγωγή χρήσιμων συμπερασμάτων (Γαλάνης, 2009).  

Μεταξύ των μη χωρικών στατιστικών αναλύσεων είναι ο υπολογισμός των 

μέτρων κεντρικής θέσης και διασποράς όπως η ελάχιστη τιμή, η μέγιστη τιμή, ο 

μέσος όρος, η τυπική απόκλιση κ.ά.  

Άλλη μη χωρική μέθοδος στατιστικής ανάλυσης, την οποία εφαρμόσαμε κατά 

την έρευνά μας είναι η συσχέτιση. Το είδος και το μέγεθος της γραμμικής σχέσης 

μεταξύ δύο ποσοτικών μεταβλητών που ακολουθούν την κανονική κατανομή 

εκτιμάται με το συντελεστή συσχέτισης του Pearson.  

Ο συντελεστής του Pearson δεν έχει μονάδες μέτρησης και λαμβάνει τιμές από 

-1 έως +1. Οι τιμές -1 έως +1 συμβαίνουν όταν υπάρχει μια τέλεια (αρνητική ή 

θετική, αντίστοιχα) γραμμική σχέση μεταξύ των δύο μεταβλητών. Όταν ο 

συντελεστής συσχέτισης λαμβάνει την τιμή 0 σημαίνει ότι δεν υπάρχει γραμμική 

σχέση μεταξύ των δύο μεταβλητών, αλλά δεν αποκλείεται η ύπαρξη μιας άλλης μη 

γραμμικής σχέσης.  

Εάν το μέγεθος της μιας μεταβλητής τείνει να αυξάνεται όπως αυξάνεται το 

μέγεθος και της άλλης μεταβλητής, τότε υπάρχει θετική συσχέτιση μεταξύ των δύο 

μεταβλητών και ο συντελεστής συσχέτισης είναι θετικός.  

Αντίθετα, εάν το μέγεθος της μιας μεταβλητής τείνει να αυξάνεται όπως 

ελαττώνεται το μέγεθος της άλλης μεταβλητής, τότε υπάρχει αρνητική συσχέτιση 

μεταξύ των δύο μεταβλητών και ο συντελεστής συσχέτισης είναι  αρνητικός.  
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Παλινδρόμηση 
 

Η παλινδρόμηση είναι μια ευρέως χρησιμοποιημένη στατιστική τεχνική 

μοντελοποίησης για την έρευνα της συσχέτισης μεταξύ μίας εξαρτώμενης 

μεταβλητής και μιας ή περισσότερων ανεξάρτητων μεταβλητών.  

Ο κλάδος της Στατιστικής που εξετάζει τη σχέση μεταξύ δύο ή περισσότερων 

μεταβλητών με απώτερο στόχο την πρόβλεψη μιας απ’ αυτές μέσω των άλλων 

λέγεται ανάλυση παλινδρόμησης (regression analysis) (Κούτρας, 2011).  

Με την ανάλυση παλινδρόμησης εξετάζουμε τη σχέση μεταξύ δύο ή 

περισσοτέρων μεταβλητών με σκοπό την πρόβλεψη των τιμών της μιας, μέσω των 

τιμών της άλλης (ή των άλλων). Σε κάθε πρόβλημα παλινδρόμησης διακρίνουμε δύο 

είδη μεταβλητών: τις ανεξάρτητες ή ελεγχόμενες ή επεξηγηματικές (independent, 

predictor, casual, input, explanatory variables) και τις εξαρτημένες ή απόκρισης 

(dependent, response variables),  

(http://www.aua.gr/gpapadopoulos/files/regression12a.pdf, 15/09/2014). 

Στην απλή παλινδρόμηση, χρησιμοποιούμε μόνο μια μεταβλητή χ (ανεξάρτητη 

μεταβλητή), και μία δεύτερη μεταβλητή y (εξαρτημένη μεταβλητή), η οποία μπορεί 

να προσεγγιστεί ικανοποιητικά από μία συνάρτηση του χ, για παράδειγμα η y να 

εκφράζεται μέσω της χ ως y=3x + 5 (Κούτρας, 2011). 

Η παλινδρόμηση στην οποία υπάρχει μόνο μια ανεξάρτητη μεταβλητή καλείται 

απλή παλινδρόμηση ενώ αν υπάρχουν περισσότερες από μία ανεξάρτητες μεταβλητές 

λέγεται πολλαπλή παλινδρόμηση (Κούτρας, 2011). 

 

 

Απλή Γραμμική Παλινδρόμηση 
 

Στη Στατιστική, γραμμική παλινδρόμηση είναι μια προσέγγιση 

μοντελοποίησης της σχέσης μιας απλής εξαρτημένης (dependent) μεταβλητής y με 

μια ή περισσότερες ανεξάρτητες (independent) μεταβλητές x1,x2, …xn.  

Η μεταβλητή/ες xi δεν θεωρείται/ούνται τυχαία/ες ενώ η y θεωρείται τυχαία 

μεταβλητή. Στην περίπτωση που έχουμε μια μόνο ανεξάρτητη μεταβλητή x τότε η 

μοντελοποίηση ονομάζεται απλή γραμμική παλινδρόμηση. 

 

http://www.aua.gr/gpapadopoulos/files/regression12a.pdf
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Διάγραμμα 2:  Απλή Γραμμική Παλινδρόμηση 

 

Στην απλή γραμμική παλινδρόμηση υπάρχει η ανεξάρτητη μεταβλητή xi, και 

δύο παράμετροι βο, β (συντελεστές παλινδρόμησης -  regression coefficients) εκ των 

οποίων η πρώτη είναι ο σταθερός όρος, και ο δεύτερος είναι ο συντελεστής της 

μεταβλητής xi. 

Το μοντέλο έχει τη μορφή:      yi= βο + β1xi + εi    όπου ε είναι το σφάλμα της 

πρόβλεψης (error) ή αλλιώς υπόλοιπο (residual), (Τσαρακτίδης, 2008). Σε ένα πιο 

γενικό πρόβλημα με p ανεξάρτητες μεταβλητές το μοντέλο έχει τη μορφή :  

yi= βο + β1xi + .. + βpixpi+ εi 

 

Αξιολόγηση μοντέλου γραμμικής παλινδρόμησης 

Η ευθεία γραμμικής παλινδρόμησης δίνει πρόβλεψη της άγνωστης τιμής της 

εξαρτημένης μεταβλητής. Η ποιότητα της πρόβλεψης αυτής ελέγχεται από την τιμή 

του συντελεστή προσδιορισμού (Coefficient of determination) R2 (R – Square), το 
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οποίο ερμηνεύεται ως το ποσοστό της μεταβλητότητας των τιμών της εξαρτημένης 

μεταβλητής που προσδιορίζεται από τις τιμές της ανεξάρτητης μεταβλητής, και είναι 

καλό να είναι μεγάλο δηλαδή κοντά στη μονάδα. 

 
 
2.5.2 Μέθοδοι Χωρικής Στατιστικής  
 

Στη στατιστική μιας μεταβλητής, εξετάζεται η συμπεριφορά ενός πληθυσμού ή 

ενός δείγματος μετρήσεων ενός μόνου φυσικού μεγέθους. Στατιστική μιας 

μεταβλητής εφαρμόζεται, για παράδειγμα, στην περίπτωση όπου έχουμε να 

επεξεργαστούμε μετρήσεις θερμοκρασίας ενός μετεωρολογικού σταθμού σε έναν 

τόπο. Υπάρχουν όμως περιπτώσεις όπου στα δεδομένα των μετρήσεων υπεισέρχεται 

και ο γεωγραφικός παράγοντας, που συνήθως εκφράζεται με τις συντεταγμένες χ, y 

των σταθμών όπου μετράται το φυσικό μέγεθος.  

Για παράδειγμα οι μετρήσεις θερμοκρασίας σε διάφορους σταθμούς, με 

διαφορετικές χωρικές συντεταγμένες, συνιστούν ένα σύνολο δεδομένων όπου, πέρα 

από τις τιμές του μετρούμενου φυσικού μεγέθους, υπεισέρχεται και η γεωγραφική 

διάσταση. Η επεξεργασία δεδομένων όταν λαμβάνονται υπόψη και οι χωρικές 

συντεταγμένες τους αποτελεί αντικείμενο της χωρικής στατιστικής. 

Οι θέσεις όπου καταγράφεται ένα γεγονός, ή μετράται ένα φυσικό μέγεθος, 

συχνά αναπαριστάνονται ως σημεία στο γεωγραφικό χώρο των δύο διαστάσεων. Ένα 

τέτοιο υποσύνολο μπορεί να περιέχει μόνο γεωγραφική πληροφορία (π.χ. 

συντεταγμένες ηφαιστείων σε έναν ευρύτερο γεωγραφικό χώρο), ή να περιέχει 

γεωγραφική πληροφορία μαζί με πληροφορία για την τιμή φυσικών μεγεθών (π.χ. 

τιμές ραδιενέργειας σε δίκτυο σταθμών μέτρησης που καλύπτει μια ευρύτερη 

περιοχή) (Βαϊόπουλος και συν., 2007). 
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Διάγραμμα 2.1: Τάση μεταβολής των τιμών στο χώρο 

Πηγή: Ζάγκλαρης Ιωάννης, (2013), Εργασία για το μάθημα «Γεωστατιστική», ΠΜΣ τμήματος 
Αξιοποίησης Φυσικών Πόρων & Γεωργικής Μηχανικής 

 

 

Περιληπτικά, η χωρική στατιστική είναι η εφαρμογή της θεωρίας των 

πιθανοτήτων σε δεδομένα που απαντώνται στον χώρο μας και επηρεάζονται μόνο από 

την θέση τους στο χώρο αυτό. Η διαφορά από την συμβατική στατιστική είναι το ότι 

προσπαθεί να αναδείξει την δομή των στοιχείων και την σχέσης τους στο χώρο 

ανεξαρτήτως της δεδομένης πολυπλοκότητας που έχουν τα φυσικά φαινόμενα 

(Καπαγερίδης, 2010) 

 

 

 

Γεωγραφικά Σταθμισμένη Παλινδρόμηση 
 

Η διαφορά της γεωγραφικά σταθμισμένης παλινδρόμησης από την γραμμική 

παλινδρόμηση έγκειται στο γεγονός ότι στη γεωγραφικά σταθμισμένη παλινδρόμηση 

οι παρατηρήσεις οι οποίες λαμβάνονται υπόψη στη διαμόρφωση του υποδείγματος 

σταθμίζονται με βάρος τη γεωγραφική τους θέση (Μηλάκα και συν., 2010). 

Όπως χαρακτηριστικά αναφέρουν οι Fotheringham και Wong (Rogerson, 2001) 

η παλινδρόμηση είναι δυνατόν να αποδώσει εντελώς διαφορετικά συμπεράσματα 

ανάλογα με το χωρικό πεδίο αναφοράς της εφαρμογής. Η διαπίστωση ότι ο χώρος 



 40 

χαρακτηρίζεται από έντονες διαφοροποιήσεις ενισχύει τη μετάβαση της ανάλυσης 

από το υπερτοπικό επίπεδο (global) στο τοπικό επίπεδο (local) με τη δυναμική 

εισαγωγή της χωρικής παραμέτρου (location). 

Στη συγκεκριμένη παλινδρόμηση το μοντέλο διαφοροποιείται σε σχέση με τη 

γραμμική παλινδρόμηση και έχει την εξής μορφή:  

yi= βο (xi , yi)+ β1(xi , yi)xi + .. + βpi (xi , yi)xpi+ εi 

όπου (xi , yi) = η θέση των παρατηρήσεων i με συντεταγμένες xi και yi 

 

Επίσης,      ( ) ( )[ ] ( )Yy,xWX  Xy,xWX,yxβ̂ ii
T1

ii
T

ii ⋅= −  

όπου:   ( ) =ii y,xW    ο πίνακας βαρών για κάθε θέση. 

 

 

Μορφή του μοντέλου  

Για να καλυφθεί η ανάγκη της χωρικής μεταβολής, το μέγεθος ( )ii y,xW    δεν 

αναφέρεται μόνο στη θέση (xi, yi) αλλά σε ένα σύνολο σημείων γύρω από αυτή, 

δηλαδή σε μια περιοχή ακτίνας ri, έτσι ώστε οι παρατηρήσεις κοντά στο (xi, yi) να 

έχουν μεγαλύτερο βάρος από τις παρατηρήσεις που βρίσκονται μακρύτερα.  

 

Ο πίνακας βαρών έχει τη μορφή:    ( )


















=

in

i2

i1

ii

w00

0w0
00w

y,xW









 

 

όπου:     =ijw  το βάρος των τιμών των μεταβλητών για κάθε σημείο j που βρίσκεται 

στην περιοχή ri γύρω από το (xi, yi).  

 

Ο πίνακας βαρών είναι ένας διαγώνιος πίνακας, τα στοιχεία του οποίου αντιστοιχούν 

στα βάρη της σταθμισμένης παλινδρόμησης γύρω από τη θέση (xi, yi). 
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Υπολογισμός Στάθμισης Βαρών 

 

Ο προσδιορισμός της ακτίνας της περιοχής γύρω από τη θέση (xi, yi) ή του σημείου 

παλινδρόμησης, που ονομάζεται πυρήνας, παίζει σημαντικό ρόλο: 

 Αν η ακτίνα είναι πολύ μεγάλη, τότε τα στοιχεία που 

συμπεριλαμβάνονται στην εκτίμηση των συντελεστών θα καλύπτουν 

όλη την περιοχή μελέτης. 

 Αν είναι πολύ μικρή, τότε οι τιμές τους θα παρουσιάζουν μεγάλο 

τυπικό σφάλμα.  

 

Για τον υπολογισμό του μοντέλου, θεωρείται ότι κάθε παρατήρηση j (στην περιοχή ri) 

σταθμίζεται με ένα βάρος wij, ο υπολογισμός του οποίου μπορεί να γίνει με δύο 

βασικές ομάδες τρόπων στάθμισης:   

 Η πρώτη ομάδα αφορά τρόπους στάθμισης που είναι αμετάβλητοι, 

δηλαδή χαρακτηρίζονται από ένα σταθερό εύρος ζώνης h. 

 Η δεύτερη ομάδα αφορά αυτούς που είναι προσαρμόσιμοι, δηλαδή 

χαρακτηρίζονται από ένα σταθερό αριθμό σημείων παρατήρησης n. 

 

Με σταθερό τρόπο στάθμισης ο πιο συχνά χρησιμοποιούμενος είναι με τη χρήση της 

συνάρτησης Gauss ως εξής: 

 

                 
( )2hd 21 ije−

  ,    αν    di < h                    

  ijw   

                    0                 ,    αν    di ≥ h 

 

 

Σε κάθε θέση I, με σταθερό εύρος ζώνης h, το βάρος στο σημείο j είναι wij, όπου dij 

είναι η απόσταση παλινδρόμησης i και του σημείου παρατήρησης j. 
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Ο πιο γνωστός προσαρμόσιμος τρόπος στάθμισης έχει ως εξής: 

    

                     ( )[ ]2 2
iij hd1− αν    dij ≤ h 

 

                              0                      αν     dij > h 

 

Σε κάθε θέση i, το βάρος στο σημείο j είναι wij, όπου dij είναι η απόσταση μεταξύ i 

και j και hi, είναι η απόσταση του j-οστού κοντινότερου σημείου από το σημείο i (hi 

= dij). 

 

 

Τρόποι Αξιολόγησης της Τοπικής Παλινδρόμησης  

o Για τη σταθερή απόσταση ο δείκτης ονομάζεται Cross validation Score: 

( )[ ]∑ ≠−=
i

2
ii  hŶYCVS  

 

όπου: =≠iŶ   η εκτιμηθείσα τιμή του Yi, όταν οι παρατηρήσεις  του σημείου  δεν 

έχουν συμπεριληφθεί στην  παλινδρόμηση. 

 

 

o Για την προσαρμόσιμη απόσταση ο δείκτης ονομάζεται Akaine Information 

Criterion: 

        

AIC = Απόκλιση + ( )[ ]1knnk2 −−  

 

όπου: n = ο αριθμός των σημείων παρατήρησης 

          k = ο αριθμός των συντελεστών του μοντέλου 

 
 

Ο δείκτης AICc δείχνει πόσο ταιριάζει το μοντέλο παλινδρόμησης που 

χρησιμοποιείται στα δεδομένα. Όσο πιο μικρό είναι το ποσοστό του δείκτη AICc, 

τόσο πιο αξιόπιστα είναι τα δεδομένα (Propastin et al., 2006).   

ijw
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Επιπροσθέτως να τονιστεί ότι η ανάλυση των αποτελεσμάτων της Γεωγραφικά 

Σταθμισμένης Παλινδρόμησης ολοκληρώνεται μελετώντας το τοπικό - Local R2. Το 

Local R2 κυμαίνεται μεταξύ 0 και 1 και μας υποδηλώνει πόσο καλά η τοπική 

παλινδρόμηση (το τοπικό μοντέλο) ταιριάζει στις παρατηρούμενες τιμές. Πολύ 

χαμηλές τιμές υποδηλώνουν ότι το μοντέλο δεν έχει καλή εφαρμογή.   
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ΕΝΟΤΗΤΑ 3: ΠΑΡΟΥΣΙΑΣΗ ΚΑΙ ΑΝΑΛΥΣΗ ΤΕΛΙΚΩΝ 

ΑΠΟΤΕΛΕΣΜΑΤΩΝ  
 

 

3.1  Προεπεξεργασία δεδομένων 
 

Τα δεδομένα που αναφέρθηκαν προηγουμένως προτού χρησιμοποιηθούν 

έπρεπε να διορθωθούν με τέτοιο τρόπο έτσι ώστε να είναι επεξεργάσιμα. Τα βήματα 

που ακολουθήθηκαν ήταν τα εξής:  

Οι έξι δορυφορικές εικόνες που απεικόνιζαν το δείκτη NDVI (δείκτης 

κανονικοποιημένης βλάστησης) και η εικόνα DEM δεν μπορούσαν να επεξεργαστούν 

στο λογισμικό ArcGIS στη συγκεκριμένη μορφή και για αυτόν ακριβώς τον λόγο 

εισήχθησαν στο λογισμικό ENVI. Κατόπιν της εισαγωγής τους έγινε εξαγωγή αυτών 

σε μορφή  GEO TIFF, προκειμένω να μπορούν να επεξεργαστούν μετέπειτα. 

Τα νέα επεξεργάσιμα δεδομένα αφού εισήχθησαν στο λογισμικό ArcGIS 

έπρεπε να ελεγχθούν ως προς το σύστημα συντεταγμένων – Γεωδαιτικό Σύστημα 

αναφοράς. Το Γεωδαιτικό Σύστημα Αναφοράς των εικόνων δεν ήταν το Ελληνικό, 

ΕΓΣΑ 87, αλλά το WGS 84 και γι’ αυτό πραγματοποιήθηκε μετατροπή προκειμένω 

να αποκτήσουν τις σωστές συντεταγμένες. 

Η μετατροπή έγινε μέσω της εντολής Data Management Tools -> Projections 

and Transformations -> Raster -> Define Projection. 

Έπειτα παρατηρήσαμε ότι και οι έξι δορυφορικές εικόνες του δείκτη NDVI 

είχαν τιμές με πολλά δεκαδικά ψηφία (εικόνα 10). Γνωρίζουμε ότι για να επιτευχθεί η 

ένωση πολλών αρχείων raster σε ένα αρχείο raster με ενιαίο πίνακα δεδομένων 

(attributes table) πρέπει οι τιμές στον πίνακα δεδομένων να είναι ακέραιες. Συνεπώς 

πολλαπλασιάσαμε το κάθε αρχείο raster ξεχωριστά επί ένα εκατομμύριο προκειμένω 

να δημιουργηθούν έξι νέα πλεγματικά αρχεία όπου οι τιμές θα είναι ακέραιες (το 

αρχείο DΕΜ είχε ακέραιες τιμές και δεν χρειαζόταν περαιτέρω επεξεργασία). Η 

συγκεκριμένη διαδικασία έγινε μέσω της εντολής Spatial Analyst Tools -> Map 

Algebra -> Raster Calculator.   
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Εν συνεχεία, αφού όλα τα πλεγματικά μας δεδομένα ήταν πλέον σωστά 

εισάγαμε και τα δύο διανυσματικά αρχεία μορφής shapefile. Το υδρογραφικό και το 

οδικό δίκτυο. 

Καθώς εισάγαμε τα δύο αυτά αρχεία παρατηρήσαμε ότι δεν είχαν κάποιο 

γεωδαιτικό σύστημα αναφοράς, οπότε χρησιμοποιήσαμε εκ νέου την εντολή define 

projection προκειμένω να διορθώσουμε το σφάλμα. Εν τέλει, τα δεδομένα ήταν 

διαθέσιμα προς χρήση. 

 

 

 

3.2 Επεξεργασία δεδομένων – Ανάλυση δεδομένων 
 
 

Το αποτέλεσμα της προεπεξεργασίας ήταν η διόρθωση και η δημιουργία έξι 

νέων πλεγματικών αρχείων, η διόρθωση των δύο διανυσματικών αρχείων και η 

διόρθωση του αρχείου DEM ως προς το προβολικό σύστημα. 

Εν συνεχεία, ψηφιοποιήθηκε το πολύγωνο της φωτιάς χρησιμοποιώντας ως 

υπόβαθρο μία από τις εικόνες NDVI. Αυτό συνέβη διότι οι εικόνες γύρω από το 

πολύγωνο είχαν ένα μαύρο πλαίσιο το όποιο έπρεπε να αφαιρεθεί. Κατά αυτόν τον 

τρόπο το πολύγωνο που δημιουργήσαμε χρησιμοποιήθηκε ως μάσκα προκειμένω να 

αφαιρεθεί το μαύρο πλαίσιο. Βέβαια, η μάσκα χρησιμοποιήθηκε και στον ορισμό της 

καμένης περιοχής όλων των διανυσματικών αρχείων καθώς τα διανυσματικά αρχεία 

αφορούσαν ολόκληρη την Περιοχή της Πάρνηθας.  

 

Συγκεκριμένα, χρησιμοποιήθηκε η εντολή Spatial Analyst Tools -> Extraction -

> Extract by mask. 

 

 



 46 

 
Εικόνα 3.1: Εικόνα της καμένης περιοχής πριν την επεξεργασία 

 

 
 

 
Εικόνα 3.2: Εικόνα της καμένης περιοχής μετά την επεξεργασία 

 



 

Παρακάτω παρουσιάζονται οι εικόνες NDVI για τις έξι χρονικές περιόδους.  

 

Πριν τη πυρκαγιά 

  
Χάρτης 3.1: Δείκτης βλάστησης NDVI στις 16/05/2007  



 

Μετά τη πυρκαγιά 

 
 Χάρτης 3.2: Δείκτης βλάστησης NDVI στις 03/07/2007  



 

 

  
Χάρτης 3.3: Δείκτης βλάστησης NDVI στις 19/07/2007  



 

  
Χάρτης 3.4: Δείκτης βλάστησης NDVI στις 24/07/2009 

 



 

 

 
 Χάρτης 3.5: Δείκτης βλάστησης NDVI στις 12/08/2010 



 

 

 
Χάρτης 3.6: Δείκτης βλάστησης NDVI στις 15/08/2011
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Στο επόμενο βήμα, δημιουργήθηκαν τρία νέα πλεγματικά αρχεία. Η κλίση (slope) και 

η έκθεση (aspect) του ανάγλυφου και η ηλιακή ακτινοβολία (solar radiation) που 

δέχεται το ανάγλυφο. Και τα τρία αυτά αρχεία δημιουργήθηκαν βάσει του αρχείου 

DEM. Συγκεκριμένα, οι εντολές που χρησιμοποιήθηκαν ήταν οι εξής: 

 

1. 3D Analyst Tools -> Raster Surface -> Slope [degrees from horizontal (0–

90)]  

2. 3D Analyst Tools -> Raster Surface -> Aspect (degrees from north) 

3. Spatial Analyst Tools -> Solar Radiation [Kilowatt hours per square meter 

(kWH/m2)] 

 

 

 

 
Χάρτης 3.7: Υψόμετρο (σε μέτρα) της Πάρνηθας  
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Χάρτης 3.8: Προσανατολισμός (σε μοίρες) Πάρνηθας 
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Χάρτης 3.9: Κλίση (σε μοίρες) Πάρνηθας 
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Χάρτης 3.10: Χρήσεις γης στην περιοχή της  Πάρνηθας 

 

Το επόμενο βήμα που ακολουθήθηκε ήταν η μετατροπή δεδομένων σε 

πλεγματικά προκειμένω όλα τα δεδομένα να έχουν την ίδια μορφή για να μπορούν να 

συνδυαστούν. Τοιουτοτρόπως, εκτελέστηκε η εντολή Conversion Tools -> To Raster 

-> Feature to Raster.  

 

Εφόσον τα διανυσματικά δεδομένα έγιναν πλεγματικά, έπρεπε πλέον να 

αξιοποιήσουμε σωστά το πλεγματικό αρχείο με το οδικό δίκτυο και το πλεγματικό 

αρχείο με το υδρογραφικό δίκτυο. Αυτό που θέλαμε, ήταν, τα κελιά – ψηφίδες των 

δύο αυτών πλεγματικών αρχείων να αποκτήσουν ως πληροφορία την απόσταση από 

το οδικό και το υδρογραφικό δίκτυο αντίστοιχα. Η διαδικασία αυτή επετεύχθη με την 

εντολή Spatial Analyst Tools -> Distance -> Euclidian Distance.  

 

Ολοκληρώνοντας αυτό το βήμα, τα αρχεία ήταν έτοιμα για συνδυασμό, 

προκειμένω να έχουμε μία εικόνα με έναν πίνακα δεδομένων, ο οποίος θα 

συμπεριελάμβανε τα δεδομένα όλων των επιπέδων πληροφοριών. Η εντολή που 
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εκτελέστηκε σε αυτό το βήμα ήταν Spatial Analyst Tools -> Local->  Combine. Στην 

Εικόνα 3.3 παρουσιάζεται τμήμα των δεδομένων που συνθέτουν το ενιαίο αρχείο. 

 

 
Εικόνα 3.3: Πίνακας περιγραφικών δεδομένων  (τιμές NDVI * 1.000.000) 

 

Τελειώνοντας, διαπιστώνουμε ότι στο αρχείο που δημιουργήσαμε δεν υπάρχουν 

συντεταγμένες των σημείων. Οπότε προχωρήσαμε στην προσθήκη αυτών 

ακολουθώντας τα παρακάτω βήματα: 

 

• Δημιουργούμε δύο στήλες. Μία με όνομα Xcoord και μία με Ycoord και type 

επιλέγουμε Double. 

• Έπειτα επιλέγουμε το field calculator και την επιλογή Advanced. Αυτή τη 

διαδικασία την εκτελούμε μία για τη στήλη Xcoord και μία για τη Ycoord. 

 

Κατόπιν πραγματοποιήσαμε συγκεκριμένους στατιστικούς υπολογισμούς 

προκειμένω να εξάγουμε κάποια συμπεράσματα για τα δεδομένα μας  Η πρώτη 

ενέργεια που πραγματοποιήσαμε ήταν ο υπολογισμός: 

o της ελάχιστη τιμής 

o της μέγιστης τιμής  

o του μέσου όρου  

o της τυπικής απόκλισης 
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κάθε εικόνας NDVI και όλων των παραγόντων που χρησιμοποιήθηκαν (μέσω της 

εντολής Analyze -> Descriptive Statistics -> Descriptives στο στατιστικό πακέτο SPSS). 
 

 

Πίνακας 3.1: Περιγραφικά Στατιστικά Μεταβλητών 
 

 Πλήθος 
Στοιχείων 

Ελάχιστη 
Τιμή 

Μέγιστη 
Τιμή 

Μέσος  
Όρος 

Τυπική 
Απόκλιση 

ndvi_16/05/2007 50138 ,10 ,72 ,4995 ,07084 

ndvi_03/07/2007 50138 -,11 ,31 ,0849 ,05028 

ndvi_19/07/2007 50138 -,02 ,37 ,0899 ,04979 

ndvi_24/07/2009 50138 ,08 ,60 ,2589 ,09207 

ndvi_12/08/2010 50138 ,08 ,61 ,2640 ,09015 

ndvi_15/08/2011 50138 -,02 ,63 ,2976 ,09686 

Υψόμετρο (Dem) 50138 311,00 1222,00 811,7022 163,67312 

Κλίση (Slope) 50138 ,00 46,85 12,8839 7,43929 

Έκθεση (aspect) 50138 ,52 360,00 205,7836 109,62441 

Απόσταση από 
υδρογραφικό 
δίκτυο 

50137 ,00 657,00 124,4717 98,46358 

Απόσταση από 
δρόμους 

50138 ,00 1760,00 407,5724 381,18110 

Χρήσεις γης – 
corine (κωδικοί 
corine) 

50138 211,00 324,00 312,1786 18,04114 

Ηλιακή 
ακτινοβολία 
(kWH/m2) 

50138 1600,00 1751,00 1702,00 58,8356 

      
 

Όπως παρατηρούμε στον Πίνακα 3.1 οι τιμές όλων των παραγόντων αλλά και 

των εικόνων NDVI, εμφανίζονται όπως ακριβώς θα περιμέναμε.  

Στις πρώτες δύο δορυφορικές εικόνες, οι οποίες αφορούν το δείκτη βλάστησης 

ακριβώς μετά τη πυρκαγιά (03/07/2007 και 19/07/2007) παρατηρούμε ότι 

παρουσιάζονται οι μικρότερες τιμές στο δείκτη βλάστησης (ελάχιστη & μέγιστη τιμή, 

μέσος όρος, τυπική απόκλιση).  
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Το αποτέλεσμα αυτό ήταν απολύτως αναμενόμενο καθώς οι συγκεκριμένες 

δορυφορικές εικόνες αφορούν το δείκτη βλάστησης ένα μόλις μήνα μετά την 

πυρκαγιά, όπου η βλάστηση δεν έχει καταφέρει να αναγεννηθεί. Αντίθετα, στις 

επόμενες δορυφορικές εικόνες παρατηρούμε ότι οι τιμές αυξάνονται. Αυτό σημαίνει 

με έναν πρώτο έλεγχο ότι υπάρχει αύξηση της βλάστησης (Quayle et al., 2005). 

Στο επόμενο βήμα, υπολογίσαμε τη συσχέτιση μεταξύ των δεικτών βλάστησης 

και των παραγόντων που εξετάζουμε την επίδρασή τους στην αναβλάστηση (μέσω της 

εντολής  Analyze -> Correlate -> Bivariate στο στατιστικό πακέτο SPSS). Τα αποτελέσματα τους 

παρουσιάζονται στον Πίνακα 3.3.  

Παρατηρώντας τα αποτελέσματα συμπεραίνουμε ότι υπάρχει αρνητική 

συσχέτιση μεταξύ των δύο δορυφορικών εικόνων (03/07/2007 και 19/07/2007), οι 

οποίες είναι ακριβώς μετά την πυρκαγιά, σε σχέση με την δορυφορική εικόνα πριν 

την πυρκαγιά (16/05/2007). Το αποτέλεσμα αυτό φανερώνει την σημαντική 

καταστροφή της πυρκαγιάς: όσο εντονότερη βλάστηση υπήρχε πριν την φωτιά τόσο 

μεγαλύτερη η καταστροφή ενώ εκεί που είχαμε πολύ μικρή βλάστηση (και επομένως 

δικαιολογημένα ελάχιστες καταστροφές) φάνηκε μια τάση αύξησής της μετά από 1-2 

μήνες.  

Μία άλλη παρατήρηση που μπορούμε να κάνουμε είναι ότι όσο πιο πολύ 

απομακρυνόμαστε από το υδρογραφικό δίκτυο τόσο μικρότερη βλάστηση θα 

συναντάμε (r= -,160**). Αυτή η σχέση διαταράσσεται φυσικά με την πυρκαγιά και 

αποκαθίσταται σιγά-σιγά μέχρι το 2011 (r = -,141**). Να αναφέρουμε ότι όλες οι 

τιμές των συντελεστών συσχετίσεων αν και είναι μικρές γεγονός που σημαίνει 

ασθενή συσχέτιση,  είναι στατιστικά σημαντικές. 

Επίσης, στον παρακάτω πίνακα δεν αναφέραμε το p-value δηλαδή το Sig (2-

tailed) καθώς παρατηρήσαμε ότι για όλους τους παράγοντες το p-value ήταν 

μικρότερο του 0,05 κάτι το οποίο σημαίνει ότι υπάρχει στατιστικώς σημαντική 

συσχέτιση μεταξύ όλων των  μεταβλητών. Δεν υπήρξε δηλαδή μεταβλητή, η οποία 

δεν είχε γραμμική συσχέτιση με κάποια άλλη. Παρατηρήθηκε ότι οι τιμές πολλών 

μεταβλητών έχουν δύο αστερίσκους (**). Αυτό σημαίνει ότι είναι στατιστικά 

σημαντικές σε επίπεδο ένα τοις χιλίοις (0,001). 



 

Πίνακας 3.2: Συσχετίσεις (correlations) κατά Pearson 
 
** : Οι μεταβλητές είναι στατιστικά σημαντικές σε επίπεδο 0.001 
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ndvi_16/05/2007 1 -,305** -,341** ,385** ,450** ,465** ,169** -0,005 -,042** -,160** ,016** 

ndvi_03/07/2007 -,305** 1 ,909** ,058** ,022** ,014** -,181** -,019** -,029** -,009* -,027** 

ndvi_19/07/2007 -,341** ,909** 1 -,024** -,063** -,071** -,122** -,014** -,040** ,003 -,061** 

ndvi_24/07/2009 ,385** ,058** -,024** 1 ,957** ,931** -,473** -,161** ,000 -,103** ,280** 

ndvi_12/08/2010 ,450** ,022** -,063** ,957** 1 ,955** -,440** -,154** ,016** -,125** ,277** 

ndvi_15/08/2011 ,465** ,014** -,071** ,931** ,955** 1 -,413** -,138** ,010* -,141** ,272** 

Υψόμετρο (Dem) ,169** -,181** -,122** -,473** -,440** -,413** 1 ,143** -,064** ,081** -,260** 

Κλίση (Slope) -,005 -,019** -,014** -,161** -,154** -,138** ,143** 1 ,000 ,006 -,015** 

Έκθεση (aspect) -,042** -,029** -,040** ,000 ,016** ,010* -,064** 0,000 1 -,005 ,049** 

Απόσταση από 
υδρογραφικό 
δίκτυο 

-,160** -.009* -,003 -,103** -,125** -,141** -,081** 0,006 -,005 1 ,070** 

Απόσταση από 
δρόμους 

,103** -,027** -,061** ,280** ,277** ,272** -,260** -,015** ,049** 
 

,070** 1 
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Πίνακας 3.3: Συσχετίσεις μεταξύ δεικτών NDVI  
 

  
ndvi_15aug 

ndvi_ 

bef_fire ndvi_3july ndvi_19jul ndvi_24jul ndvi_12aug 

Pearson Correlation ndvi_15aug 1,000 ,465 ,014 -,071 ,931 ,955 

ndvi_bef_fire ,465 1,000 -,305 -,341 ,385 ,450 

ndvi_3july ,014 -,305 1,000 ,909 ,058 ,022 

ndvi_19jul -,071 -,341 ,909 1,000 -,024 -,063 

ndvi_24jul ,931 ,385 ,058 -,024 1,000 ,957 

ndvi_12aug ,955 ,450 ,022 -,063 ,957 1,000 

Sig. (1-tailed) ndvi_15aug . ,000 ,001 ,000 ,000 ,000 

ndvi_ bef_fire ,000 . ,000 ,000 ,000 ,000 

ndvi_3july ,001 ,000 . ,000 ,000 ,000 

ndvi_19jul ,000 ,000 ,000 . ,000 ,000 

ndvi_24jul ,000 ,000 ,000 ,000 . ,000 

ndvi_12aug ,000 ,000 ,000 ,000 ,000 . 

N ndvi_15aug 50138 50138 50138 50138 50138 50138 

ndvi_ bef_fire 50138 50138 50138 50138 50138 50138 

ndvi_3july 50138 50138 50138 50138 50138 50138 

ndvi_19jul 50138 50138 50138 50138 50138 50138 

ndvi_24jul 50138 50138 50138 50138 50138 50138 

ndvi_12aug 50138 50138 50138 50138 50138 50138 
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Εν συνεχεία, με τη μέθοδο της γραμμικής παλινδρόμησης εξετάσαμε τη σχέση 

μεταξύ των μεταβλητών μας με σκοπό την πρόβλεψη της αναβλάστησης. Δηλαδή 

κατά πόσο οι ανεξάρτητες μεταβλητές μας επηρεάζουν τη διαμόρφωση της 

βλάστησης. 

Ως εξαρτημένες μεταβλητές χρησιμοποιήθηκαν οι δείκτες βλάστησης για τις έξι 

χρονικές περιόδους (NDVI 16/05/2007, NDVI 03/07/2007, NDVI 19/07/2007, NDVI 

24/07/2009, NDVI 12/08/2010, NDVI 15/08/2011) και ως ανεξάρτητες οι υπόλοιποι 

παράγοντες (υψόμετρο, κλίση, έκθεση, απόσταση από το υδρογραφικό δίκτυο, 

απόσταση από το οδικό δίκτυο, χρήσεις γης, ηλιακή ακτινοβολία). 

Οι παράγοντες μας, κατηγοριοποιήθηκαν με αυτόν τον τρόπο γιατί θέλαμε να 

εξετάσουμε κατά πόσο η αναβλάστηση επηρεάζεται από τους υπόλοιπους 

παράγοντες. 
Η εντολή που χρησιμοποιήθηκε στο λογισμικό SPSS ήταν: Analyze -> Regression -> Linear. 

 

 
Πίνακας 3.4: Αποτελέσματα Γραμμικής Παλινδρόμησης 

 
 

 
Στον ακριβώς από πάνω πίνακα παρατηρούμε το αποτέλεσμα της 

παλινδρόμησης μεταξύ μίας εξαρτημένης και των ανεξάρτητων μεταβλητών. 

Αναλυτικότερα, πραγματοποιήθηκε μία γραμμική παλινδρόμηση για κάθε δείκτη 

βλάστησης. Ο δείκτης βλάστησης ήταν πάντα η εξαρτημένη μεταβλητή. Ως 

ανεξάρτητες πάντα ορίζαμε τους παράγοντες που αναφέραμε προηγουμένως. 

Το R Square είναι το τετράγωνο του συντελεστή γραμμικής συσχέτισης και 

ονομάζεται συντελεστής προσδιορισμού. Ο συντελεστής προσδιορισμού φανερώνει 

το ποσοστό της μεταβλητότητας των δεδομένων που εξηγείται από το γραμμικό 

Εξαρτημένες μεταβλητές  Ανεξάρτητες 
μεταβλητές  R2 

NDVI 16/05/2007 
υψόμετρο,  

κλίση, έκθεση, 
απόσταση από το 

υδρογραφικό δίκτυο και 
το οδικό δίκτυο, χρήσεις 
γης, ηλιακή ακτινοβολία 

0.098 

NDVI 03/07/2007 0.099 
 

NDVI 19/07/2007 0.072 
NDVI 24/07/2009 0.206 
NDVI 12/08/2010 0.219 
NDVI 15/08/2011 0.206 
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μοντέλο που προσαρμόσαμε. Δηλαδή, το συγκεκριμένο μοντέλο εξηγεί το 9,8%, το 

9,9%, το 7,2% αντίστοιχα της μεταβλητότητας των δεδομένων. Ο προσαρμοσμένος 

συντελεστής προσδιορισμού (Adjusted R Square) έχει λάβει υπόψη του και το 

μέγεθος του δείγματος. 

Όσο μεγαλύτερο είναι το Adjusted R Square τόσο πιο αξιόπιστο είναι το 

μοντέλο μας. Το R2 μετρά δηλαδή το βαθμό αξιοπιστίας της γραμμικής 

παλινδρόμησης. 

Παρατηρώντας τον συγκεκριμένο πίνακα συμπεραίνουμε λοιπόν το μοντέλο 

μας έχει μεγαλύτερα ποσοστά τα τελευταία τρία έτη (20.6% , 20.6%, 21.9%).  

Στο επόμενο βήμα, ελέγξαμε τα υπόλοιπα στατιστικά στοιχεία τα οποία 

δημιουργήθηκαν κατά την εφαρμογή της παλινδρόμησης. Συγκεκριμένα, ελέγξαμε 

από τον πίνακα με τις εκτιμήσεις των παραμέτρων – coefficient ότι όλοι οι πίνακες 

για όλες τις παλινδρομήσεις που πραγματοποιήσαμε είχαν sig.=0.000 που σημαίνει 

ότι είναι στατιστικά σημαντικοί όλοι οι συντελεστές μας, άρα απαραίτητοι για το 

μοντέλο. 

Στο επόμενο βήμα, αποφασίσαμε να εξετάσουμε τη γραμμική παλινδρόμηση 

μεταξύ των δεικτών βλάστησης. Κάθε χρονιά δηλαδή με τις προηγούμενες χρονιές. 

Γνωρίζουμε ότι ο δείκτης NDVI χρησιμοποιείται για να δείξει την ανάπτυξη της 

βλάστησης. Επίσης, ο δείκτης NDVI σε διαφορετικά έτη μπορεί να αξιολογήσει την 

αναβλάστηση (Xijie LV, 2013). 

Κατά αυτόν τον τρόπο, εφαρμόσαμε γραμμική παλινδρόμηση στους δείκτες 

NDVI μεταξύ τους.  
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Τα αποτελέσματα ήταν τα εξής:  
 
 
 
 
Πίνακας 3.5: Αποτελέσματα γραμμικής παλινδρόμησης μεταξύ των δεικτών 
NDVI 
 

 

 

Παρατηρούμε ότι το μοντέλο μας ως μεγαλύτερη τιμή έχει το 83% και αυτό 

οφείλεται στο ότι εξετάζεται ως εξαρτημένη ο δείκτης NDVI που έχει ημερομηνία 

19/07/2007 με τους δείκτες NDVI που έχουν 16/05/2007 και 03/07/2007.  

 
 

Εξαρτημένες μεταβλητές  Ανεξάρτητες 
μεταβλητές  R2 

NDVI 03/07/2007 NDVI 16/05/2007 0.093 

NDVI 19/07/2007 

 
NDVI 16/05/2007  
NDVI 03/07/2007 

 

0.831 

NDVI 24/07/2009 

 
NDVI 16/05/2007 
NDVI 03/07/2007 
NDVI 19/07/2007 

 

0.197 
 

NDVI 12/08/2010 

 
NDVI 16/05/2007 
NDVI 03/07/2007 
NDVI 19/07/2007 
NDVI 24/07/2009 

 

0.923 
 

NDVI 15/08/2011 

 
NDVI 16/05/2007 
NDVI 03/07/2007 
NDVI 19/07/2007 
NDVI 24/07/2009 
NDVI 12/08/2010 

 

0.91 
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Εφόσον ολοκληρώθηκε η εφαρμογή του μοντέλου της γραμμικής 

παλινδρόμησης ακολούθησε η εφαρμογή του μοντέλου της Γεωγραφικά 

Σταθμισμένης Παλινδρόμησης (GWR) προκειμένω να διαπιστώσουμε κατά πόσο ο 

χώρος επιδρά στην ανάπτυξη της βλάστησης.  

Η συγκεκριμένη δυνατότητα δόθηκε μέσω του λογισμικού ArcGIS και της 

εντολής Spatial Statistics Tools -> Modeling Spatial Relationships -> Geographically 

Weighted Regression.  

Βέβαια, προτού εκτελεστεί η συγκεκριμένη εντολή, μετατρέψαμε ένα 

πλεγματικό αρχείο (raster) σε σημειακό καθώς η συγκεκριμένη εντολή εκτελείται 

μόνο με αρχεία μορφής shapefile. Κατόπιν, προσθέσαμε όλο τον πίνακα των 

δεδομένων του συνολικού raster αρχείου στο νέο σημειακό αρχείο, προκειμένω να 

περιλαμβάνει όλους τους παράγοντες.  

 

 
 
 
 

Αναλυτικά, τα αποτελέσματα ήταν τα εξής: 
 
 

Πίνακας 3.6: Αποτελέσματα Γεωγραφικά Σταθμισμένης Παλινδρόμησης -
GWR 

 

Εξαρτημένες μεταβλητές  Ανεξάρτητες 
μεταβλητές  R2 

NDVI 16/05/2007 
υψόμετρο,  

κλίση, έκθεση, 
απόσταση από το 

υδρογραφικό δίκτυο και 
το οδικό δίκτυο, χρήσεις 
γης, ηλιακή ακτινοβολία 

0,724 

NDVI 03/07/2007 0,488 
 

NDVI 19/07/2007 0,482 
NDVI 24/07/2009 0,632 
NDVI 12/08/2010 0,686 

NDVI 15/08/2011 0,706 
 



 66 

Παρατηρείται, ότι το R2  έχει πολύ μεγάλο ποσοστό σε σχέση με αυτό που είχε 

στη γραμμική παλινδρόμηση. Αυτό συνεπάγεται ότι ο γεωγραφικός χώρος αλλάζει τα 

αποτελέσματα του μοντέλου πρόβλεψης.  

Κατά την εξαγωγή των αποτελεσμάτων ελέγξαμε εκτός από το R2 και το R2 

adjusted, το sigma (p-value) και το δείκτη AICc. Το p-value σε όλες τις 

παλινδρομήσεις κυμαινόταν μεταξύ 0,002 έως 0,004, κάτι το οποίο σημαίνει ότι είναι 

στατιστικά σημαντικά τα αποτελέσματα μας. 

Επίσης, γνωρίζουμε ότι ο δείκτης AICc δείχνει πόσο ταιριάζει το μοντέλο 

παλινδρόμησης που χρησιμοποιήσαμε στα δεδομένα μας. Όσο πιο μικρό είναι το 

ποσοστό του δείκτη AICc, τόσο πιο αξιόπιστα είναι τα δεδομένα (Propastin et al., 

2006). Στη συγκεκριμένη περίπτωση, ο δείκτης AICc όλων των παλινδρομήσεων 

ήταν πολύ χαμηλός. Συγκρίνοντας τους δείκτες μεταξύ τους παρατηρήσαμε ότι 

υπήρξαν ελάχιστες μεταβολές. Αυτό σημαίνει ότι το μοντέλο παλινδρόμησης ενός 

έτους έχει την ίδια εφαρμογή με το μοντέλο παλινδρόμησης διαφορετικού έτους. 

Δηλαδή, το μοντέλο παλινδρόμησης εμφανίζεται να έχει την ίδια εγκυρότητα για 

κάθε έτος.  

Στο σημείο αυτό να αναφέρουμε ότι εξετάστηκαν και μεμονωμένα οι 

ανεξάρτητες μεταβλητές (για παράδειγμα υψόμετρο, κλίση, οδικό δίκτυο) στο χώρο 

με κάθε εξαρτημένη (δείκτη βλάστησης) προκειμένου να δούμε τι ακριβώς ποσοστά 

θα εμφάνιζαν.  

Το συμπέρασμα για αυτήν τη διαδικασία ήταν ότι το υψόμετρο και η κλίση 

κυμαίνονται στα μεγαλύτερα ποσοστά R2 = 0.55 έως R2 =0.87 ενώ τα χαμηλότερα 

ποσοστά εμφάνισε η έκθεση με R2 =0,20 έως R2 =0,30. Παρατηρώντας αργότερα 

τους χάρτες βλάστησης της περιοχής μελέτης μπορούμε να διαπιστώσουμε ότι όντως 

τα ποσοστά ισχύουν, καθώς σε μεγαλύτερα υψόμετρα έχουμε μεγαλύτερη 

αναβλάστηση και σε σημεία με χαμηλή έκθεση μικρή αναβλάστηση. 

Παρόλα αυτά, συνεχίστηκε η ανάλυση των αποτελεσμάτων της GWR, 

μελετώντας το Local R2. Το Local R2 κυμαίνεται μεταξύ 0 και 1 και μας υποδηλώνει 

πόσο καλά η τοπική παλινδρόμηση (το τοπικό μοντέλο) ταιριάζει στις 

παρατηρούμενες τιμές. Πολύ χαμηλές τιμές υποδηλώνουν ότι το μοντέλο δεν έχει 

καλή εφαρμογή.   

Προκειμένω λοιπόν, να δούμε πως εφαρμόζεται το μοντέλο μας για κάθε 

σημείο, επιλέξαμε την κάθε παλινδρόμηση που δημιουργήσαμε για κάθε δείκτη 

βλάστησης και αλλάξαμε την τυπική απόκλιση (κατά τη δημιουργία της 



 67 

παλινδρόμησης η τυπική απόκλιση αναπαριστάται στο χάρτη) και επιλέξαμε να 

απεικονίζεται στο χάρτη το Local R2  .  

Εν τέλει παρατηρήθηκε, ότι τα σημεία τα οποία εμφανίζουν χαμηλότερα R2 

είναι τα σημεία νοτιοδυτικά και ανατολικά της περιοχής μελέτης, ενώ αυτά τα οποία 

έχουν τις υψηλότερες τιμές εμφανίζονται στο κεντρικό τμήμα της περιοχής  μελέτης. 
 

 

 

 

3.3 Συμπεράσματα 
 

Η παρούσα διπλωματική μελέτη είχε ως στόχο την αξιοποίηση των 

δυνατοτήτων της Τηλεπισκόπησης, των Γεωγραφικών Πληροφοριακών Συστημάτων 

(Geographical Information Systems – GIS) και της Στατιστικής με σκοπό τη 

δημιουργία ενός μοντέλου, το οποίο θα μπορούσε να εκτιμήσει εάν θα γίνει 

αναβλάστηση, σε ποιο βαθμό και σε ποιο τμήμα  της περιοχής μελέτης. 

 Η ανασκόπηση της βιβλιογραφίας, βοήθησε στη μελέτη της Πάρνηθας όσον 

αφορά τη χλωρίδα της και τη γεωμορφολογία της. Βάσει της ανασκόπησης αυτής, 

έγινε και η επιλογή των παραγόντων της αναβλάστησης. Οι παράγοντες που 

επιλέχθηκαν ήταν το υψόμετρο, η κλίση η έκθεση, η απόσταση από το υδρογραφικό 

και οδικό δίκτυο, οι χρήσεις γης και η ηλιακή ακτινοβολία.   

Έπειτα, μελετήθηκαν ερευνητικές εργασίες οι οποίες χρησιμοποίησαν μεθόδους 

παλινδρόμησης για να προβλέψουν την αναβλάστηση είτε ενός συγκεκριμένου είδους 

φυτού είτε γενικότερα μίας ολόκληρης περιοχής.  

Τα αποτελέσματα της βιβλιογραφικής αυτής ανασκόπησης έδειξαν ότι τα 

μοντέλα παλινδρόμησης και συγκεκριμένα τα μοντέλα της Γεωγραφικά 

Σταθμισμένης Παλινδρόμησης (Geographically Weighted Regression - GWR), 

μπόρεσαν να κάνουν την πρόβλεψη της αναβλάστησης.  

Παράδειγμα, αποτελεί η μελέτη πρόβλεψης της αναβλάστησης για μία περιοχή 

νοτιοδυτικά της Κίνας, όπου αποδείχτηκε ότι το υψόμετρο και η κλίση του εδάφους 

επηρεάζουν περισσότερο την αναβλάστηση. Στη συγκεκριμένη μελέτη, αναφέρονται 

και τα τμήματα της περιοχής για τα οποία εκτιμάται ότι θα υπάρξει αναβλάστηση 

(Tao Lu et all. , (2012). 
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Άλλο παράδειγμα, αποτελεί μία μελέτη για την περιοχή νοτιοδυτικά της 

Dakota, στις Ηνωμένες Πολιτείες Αμερικής, όπου έγινε χαρτογράφηση της πυρκαγιάς 

και ύστερα πρόβλεψη της αναβλάστησης. Διαπιστώθηκε σύμφωνα με τη μελέτη 

αυτή, ότι στις περιοχές όπου υπήρξε μεγαλύτερη ένταση της φωτιάς (burn severity) 

υπήρξε και πολύ μικρότερος ρυθμός αναβλάστησης (Xuexia Chen, et al., 2011) 

Επιπλέον, θα αναφερθούμε και σε μία άλλη έρευνα όπου γίνεται πρόβλεψη της 

αναβλάστησης σοδειάς στο Illinois των Ηνωμένων Πολιτειών Αμερικής. Στη 

συγκεκριμένη έρευνα, χρησιμοποιήθηκαν περιβαλλοντικοί παράγοντες που 

αφορούσαν τις βροχοπτώσεις, το χαλάζι, τη θερμοκρασία, τον άνεμο και 

ανθρωπογενείς παράγοντες.. Σύμφωνα λοιπόν, με τη μελέτη αυτή, προβλέφθηκε το 

τμήμα της περιοχής στο οποίο θα γίνει γρηγορότερα η αναβλάστηση αλλά 

διαπιστώθηκε και ότι μόνο οι περιβαλλοντικοί παράγοντες επηρεάζουν την 

αναβλάστηση. (Xijie LV, 2013) 

 Έχοντας λοιπόν, ως αρχικό δεδομένο ότι μπορεί να πραγματοποιηθεί 

πρόβλεψη της αναβλάστησης, ακολουθήθηκε μία σειρά μεθόδων για την πρόβλεψη 

αυτής, στην Πάρνηθα. 

Σε πρώτο στάδιο, πραγματοποιήθηκαν στατιστικοί έλεγχοι στους παράγοντες 

αναβλάστησης, που επιλέξαμε να μελετήσουμε, όπως μέγιστη και ελάχιστη τιμή, 

μέσος όρος και τυπική απόκλιση. Εν συνεχεία, για να εξεταστεί το είδος και το 

μέγεθος της γραμμικής σχέσης μεταξύ των μεταβλητών υπολογίστηκε ο συντελεστής 

συσχέτισης του Pearson.  

Κατόπιν, πραγματοποιήθηκε έρευνα της συσχέτισης μεταξύ των δεικτών NDVI 

κάθε έτους με τους παράγοντες της αναβλάστησης.  

Η έρευνα της συσχέτισης αυτής, πραγματοποιήθηκε με δύο τρόπους. Ο πρώτος 

τρόπος ήταν με τη μέθοδο μη χωρικής ανάλυσης, τη Γραμμική Παλινδρόμηση και ο 

δεύτερος ήταν με τη μέθοδο χωρικής ανάλυσης, τη Γεωγραφικά Σταθμισμένα 

Παλινδρόμηση – GWR. 

Παρατηρήθηκε ότι τα αποτελέσματα της γραμμικής παλινδρόμησης έχουν 

μεγάλη διαφορά από αυτά της γεωγραφικά σταθμισμένης παλινδρόμησης. Για την 

ακρίβεια τα ποσοστά του R2 στη γραμμική παλινδρόμηση μας δείχνουν ότι οι 

παράγοντες δεν λαμβάνουν μεγάλη συμμετοχή στην ανάπτυξη της βλάστησης, σε 

αντίθεση με την GWR όπου τα ποσοστά του R2 είναι αρκετά μεγαλύτερα.  

Τα αποτελέσματα της τοπικής παλινδρόμησης αποδεικνύουν ότι οι μέθοδοι 

τοπικής μοντελοποίησης διαθέτουν τη δυνατότητα καλύτερης ανάλυσης των χωρικών 
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δεδομένων, δεδομένου ότι μας βοηθούν να εξάγουμε αναλυτικότερη πληροφορία για 

τις συσχετίσεις μεταξύ των μεταβλητών. Επιπλέον στα τοπικά μοντέλα οι συσχετίσεις 

των ανεξάρτητων μεταβλητών με την εξαρτημένη μεταβλητή δεν είναι σταθερές στο 

χώρο αλλά αλλάζουν σημαντικά από περιοχή σε περιοχή. 

Συγκρίνοντας, λοιπόν, τους δείκτες NDVI, για όλες τις χρονικές περιόδους με 

τους δείκτες της Local GWR, βλέπουμε ότι επιβεβαιώνεται η πρόβλεψη και ότι 

σωστά αναπτύσσεται αναβλάστηση στο κεντρικό τμήμα της περιοχής. 

Εν κατακλείδι, ο γεωγραφικός χώρος είναι ο κυριότερος παράγοντας για την 

πρόβλεψη της αναβλάστησης. Η ανάλυση των δεδομένων με συντεταγμένες μας 

έδειξε ότι οι παράγοντες που επιλέξαμε για την πρόβλεψη της αναβλάστησης 

μπορούν ως ένα ποσοστό να προβλέψουν την αναβλάστηση.  
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